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Preface

How to Use This Guide

Purpose of  This guide describes the procedures for installing the GeneMapper®
This Guide ID-X Software Version 1.0 or Version 1.1 (GMID-X v1.0 or v1.1).

Chapter 1, Getting Started — Provides a roadmap to help you
determine the best approach for installing the GMID-X v1.0 or
v1.1 on the target computer.

Chapter 2, Installation Requirements — Contains the
specifications for the computers that are targeted for a new
GMID-X v1.0 or v1.1 software installation.

Chapter 3, Performing GMID-X v1.0 Pre-Installation and
GMID-X v1.1 Upgrade Procedures — Provides procedures on
backing up and exporting application data and objects, and on

uninstalling GeneMapper® ID Software Version 3.x
(GMID v3.x).

Chapter 4, Performing a Full Software Installation —
Provides procedures for installing the full software on the Data
Collection or non-Data Collection computer, to serve as the
host.

Chapter 5, Performing a Client Software Installation —
Provides procedures for installing the client software on the
Data Collection or non-Data Collection computer.

Chapter 6, Performing Post-Installation Procedures —
Describes the basic functions of registering the software,
logging into and out of the computer, and general information
following an installation.

Chapter 7, Setting Up Autoanalysis — Describes how to set up
your system to perform automatic remote or local analysis of
.fsa sample files generated on the Data Collection computer.
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How to Use This Guide

Audience

Assumptions

Text Conventions

viii

* Appendix A, Installing the Generic Updater Software —
Provides the procedure for installing the Generic Updater
Software.

+ Appendix B, Troubleshooting the Installation — Provides
possible avenues for troubleshooting and resolving software
installation problems.

* Appendix C, Glossary of Terms — Defines the terms
commonly used throughout the installation guide.

Note: For instructions on configuring the administrative features of
the software, see the GeneMapper® ID-X Software v1.0
Administrator’s Guide. For instructions on configuring the software
to prepare for analysis, see the GeneMapper® ID-X Software v1.0
Getting Started Guide and the GeneMapper® ID-X Sofiware Online
Help.

This guide is written for laboratory personnel responsible for installing
the GeneMapper ID-X Software v1.0 or v1.1.

This guide assumes that you have a working knowledge of the
Microsoft® Windows® operating system.

This guide uses the following conventions:
* Bold indicates user action. For example:
Enter 0, then press Enter for each of the remaining fields.

* [talic text indicates new or important words and is also used for
emphasis. For example:

Before analyzing, always prepare fresh matrix.

* A right arrow bracket ( » ) separates successive commands you
select from a drop-down or shortcut menu. For example:

Select File » Open » Spot Set.

Right-click the sample row, then select View Filter »
View All Runs.

GeneMapper® ID-X Software v1.0/1.1 Installation Guide



Preface
How to Use This Guide

User Attention  Two user attention words appear in Applied Biosystems user
Words documentation. Each word implies a particular level of observation
or action as described below.

Note: Provides information that may be of interest or help but is not
critical to the use of the product.

IMPORTANT! Provides information that is necessary for proper
instrument operation, accurate chemistry kit use, or safe use of a
chemical.

Examples of the user attention words appear below:

Note: The size of the column affects the run time.

Note: The Calibrate function is also available in the Control
Console.

IMPORTANT! Make certain that you uninstall the GMID v3.2
software before you install the GMID-X v1.0 or v1.1 software on the
non-Data Collection computer.

IMPORTANT! You must create a separate Sample Entry Spreadsheet
for each 96-well plate.

GeneMapper® ID-X Software v1.0/1.1 Installation Guide ix



Preface

How to Obtain More Information

How to Obtain More Information

Related
Documentation

Obtaining Adobe
Acrobat Reader

Send Us Your
Comments

The following related documents are shipped with the software:

s GeneMapper® ID-X Software Version 1.0 Administrator’s
Guide — Describes how to configure the administrative features
of the software, maintain the GMID-X and database dashboard
software, and use the command-line interface.

» GeneMapper® ID-X Software Version 1.0 Getting Started
Guide — Explains how to set up the software, set up a project,
and analyze the example data provided with the GeneMapper
ID-X Software.

s GeneMapper® ID-X Software Online Help — Describes all
features and functions of the software and provides step-by-step
procedures for using the software.

s GeneMapper® ID-X Software Version 1.0 Reference Guide —
Describes process quality values (PQVs) and algorithms.

s GeneMapper® ID-X Software Version 1.0 Quick Reference
Guide — Provides an easy-to-follow workflow for using the
software with instrument compatibility information.

* Dashboard Online Help — Provides information about the
database dashboard software.

Note: For additional information and support, see “How to Obtain
Support” on page xi.

Portable document format (PDF) versions of this guide and all
supporting documentation are available on the documentation CD
available with your software.

To open the user documentation on the CD drive, you need the
Adobe® Acrobat® Reader® software, which is available from
www.adobe.com or
www.appliedbiosystems.com/support/software.

Applied Biosystems welcomes your comments and suggestions for
improving its user documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

GeneMapper® ID-X Software v1.0/1.1 Installation Guide
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How to Obtain Support

How to Obtain Support

For HID support send an e-mail to:
HIDTechSupport@appliedbiosystems.com, or call (from within
North America only) 888.821.4443 and select option 1. For support
outside North America and internationally, please contact your
local support office or visit the Applied Biosystems support page to
obtain contact information.

For the latest services and support information for all locations, go to
http://www.appliedbiosystems.com, then click Support. At the
Support page, you can:

Access worldwide telephone and fax numbers to contact
Applied Biosystems Technical Support and Sales facilities.

Search through frequently asked questions (FAQs).
Submit a question directly to Technical Support.

Order Applied Biosystems user documents, MSDSs,
certificates of analysis, and other related documents.

Download PDF documents.
Obtain information about customer training.

Download software updates and patches.
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Chapter 1

Getting Started

This chapter covers:

Getting Started

B Start Here: Getting the Most Out of this Guide ............ 2
% B Installation Options. . ............oiiiiriiinennnn.n.. 3

Installation Requirements

!

Performing GMID-X v1.0
Pre-Installation and
GMID-X v1.1 Upgrade
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Performing a Full
Software Installation
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Performing a Client
Software Installation
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Performing Post-
Installation Procedures

!

Setting Up Autoanalysis
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n Chapter 1 Getting Started

Start Here: Getting the Most Out of this Guide

Start Here: Getting the Most Out of this Guide

Installation Guide
Overview

This chapter presents an overview of the installation options
available for GeneMapper® ID-X Software Version 1.0 or

Version 1.1 (GMID-X v1.0 or v1.1). To benefit from this guide, you
need to be familiar with your current computer and GeneMapper® ID
Software v.3.1 or v3.2 setup (if applicable).

To get started:

1. Read through Chapter 1 to become familiar with your
installation options.

See Chapter 2 for general installation requirements.
See Chapter 3 for pre-installation instructions.

See Chapter 4 for full installation instructions.

See Chapter 5 for client installation instructions.
See Chapter 6 for post-installation instructions.

See Chapter 7 for autoanalysis setup instructions.

© N o a0 A~ Db

See Appendix A, Installing the Generic Updater Software for
generic updater installation instructions.

9. See Appendix B, Troubleshooting the Installation for
troubleshooting instructions.

10. See Appendix C, Glossary of Terms, for a definition of terms
used frequently in this manual.

After you have read the applicable chapters in this guide and are
installing your software, refer to the GeneMapper® ID-X Sofiware
Administrator s Guide for information on configuring the
GeneMapper® ID-X Software administrative features and electronic
data chain of custody systems.

GeneMapper® ID-X Software v1.0/1.1 Installation Guide



Chapter 1 Getting Started n

Installation Options

Installation Options

Installation options for the GeneMapper® ID-X Software are based
on the type of computer you are on and your database-sharing
requirements.

You can either install a "full" version of the software, which consists
of both the GMID-X software and the database, or you can install a
"client" version of the software, which consists only of the GMID-X
software. The full version on a computer can function as the database
host for the client. Multiple clients can connect to the same database
through a network connection for easy data sharing.

If you choose not to install the full GMID-X v1.0 or v1.1 software
(as a co-installation) or the client GMID-X v1.0 or v1.1 software on
your 31xx or 3730 Data Collection computer, you can leave the
existing GeneMapper® ID Software Version 3.x (GMID v3.x)
installed, or you can uninstall GMID v3.x and install the Generic
Updater to generate .fsa files.

The following table provides information on the different types of
installations and where to locate the corresponding information in
this guide.

GeneMapper® ID-X Software v1.0/1.1 Installation Guide 3



n Chapter 1 Getting Started

Installation Options

Table 1 Installation Options Summary

CoRz:ter Full Installation Summary Clnegltj::'r;t::lﬁtnon Generic Updater
e Consists of Full ¢ Consists of Client N/A
Installation (with Installation
database) (no database)
¢ Non-DC computer can ¢ Non-DC computer can
be configured for Remote be configured for Remote
Non-Data Autoanalysis with 31xx Autoanalysis with 31xx
Collection DC computers DC computers
(Non-DC) ¢ Requires exporting of ¢ Requires exporting of
Computer GMID v3.x data (page 18) GMID v3.x data (page 18)
or ¢ Requires uninstallation of | e Requires uninstallation of
310 Data GMID v3.x (page 24) GMID v3.x (page 24)
Collection | ® Review Full Installation ¢ Review Client Installation
(DC) Computer Requirements Computer Requirements
Computer on page 9 prior to on page 11 prior to
installing installing
¢ Installation time: approx. | e Installation time: 5to 10
1 hour minutes
Refer to page 37 for the full Refer to page 46 for the
installation procedure. client installation procedure.
e (Consists of ¢ Consists of Client e Used on 31xx/3730
Co-Installation (31xx) Installation DC computers only,
(DC software shares (no database) to generate .fsa files
database) without installing
¢ Can be set up for Local ¢ Can be set up for Local GMID-X software
Autoanalysis Autoanalysis ¢ Requires exporting
g;g’é %r e Requires exporting of ¢ Requires exporting of of GMID v3.x data
Collectiaotr? GMID v3.x data (page 18) GMID v3.x data (page 18) (page 18)
(DC) ¢ No uninstallation of e Requires uninstallation of = * Requires
Computer GMID v3.2 required® GMID v3.x (page 24) uninstallation of

¢ |nstallation time: approx.
1 hour

Refer to page 37 for the co-
installation procedure.

¢ |nstallation time: approx.
5 to 10 minutes

Refer to page 46 for the
client installation procedure.

GMID v3.x (page 24)

¢ |[nstallationtime: less
than 1 minute

Refer to page 91 for the
generic updater
procedure.

T In order to install a client version of the software, you must first perform at least one successful full
installation. The client installation requires you to enter the Computer Name of the database host
computer during installation.

§ You must recreate all the files associated with autoanalysis (e.g. Results Groups) since old files created
as part of the GMID v3.2 integration cannot be reused. See Chapter 7, “Setting Up Autoanalysis.”

See Figure 1 to determine the steps to take based on the desired installation configuration.

GeneMapper® ID-X Software v1.0/1.1 Installation Guide
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Installation Options

Is the —
GeneMapper® ID NO o I? OVT at
Software v3.x installed g| LYl ereEnsu
on the computer? installation
YES
Non-DC or )
What type of 310 DC Export Uninstall the Perform a
< computer is it? > —> GMID v3.x » GeneMapper® ID > full or client
data¥ Software v3.x installation
31xx DC
What type of Full Export Perform a
< installation doyou ~ >—————% GMID V3. > full installation
want to perform? data#
| Client Export Uninstall the Perform a
»  GMID v3.x » GeneMapper® ID » client
datat Software v3.x installation

¥ Must upgrade to the GeneMapper® ID Software v3.x

Figure 1 Possible GeneMapper® ID-X Software installation
configurations
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Installation Requirements

This chapter covers:

Getting Started

B Installation CDs.......... .. i 8
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Installation Requirements B Verifying Your Computer Setup . ...............ccoo... 13
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Performing GMID-X v1.0
Pre-Installation and
GMID-X v1.1 Upgrade
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Performing a Full
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Performing a Client
Software Installation

]

Performing Post-
Installation Procedures

]

Setting Up Autoanalysis
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m Chapter 2 Installation Requirements
Installation CDs

Installation CDs

Three different installation CDs are available:

+ New Full Installation — The two GeneMapper® ID-X Software
Version 1.0 or Version 1.1 Full Install CDs (Disks 1 and 2)
install the full version (GeneMapper /D-X Software and multi-
user database) on the target computer. The full version CDs also
include extra Generic Updater software and an installation
Export Utility. You can install the software on any compatible
computer.
or

+ Client Installation — The GeneMapper® ID-X Software Version
1.0 or Version 1.1 Client Install CD installs the GeneMapper
ID-X Software Client on the target computer. You can install the
client on any compatible computer (including one running Data
Collection Software) and connect to any multi-user database on
the same local area network.

 Upgrade Installation (v1.1) — The GeneMapper® ID-X
Software Version 1.1 Upgrade Install CD installs the
GeneMapper /D-X Software v1.1 mixture analysis tool on the
target computer (client or full). You can install the software on
any target computer already running GeneMapper /D-X
Software v1.0 or v1.0.1. However, if you upgrade on a client
computer you must also upgrade the computer that hosts the full
multi-user database on the same local area network.

An additional CD comes with the software. This CD includes all
installation and associated GMID-X documentation.

Note: The GeneMapper® ID-X Software Version 1.0/1.1 Installation
Guide and supporting documentation are provided on a separate CD.
To open the user documentation on the CD, you need Adobe®
Acrobat® Reader® software. Download from www.adobe.com or
www.appliedbiosystems.com/support/software.

8 GeneMapper® ID-X Software v1.0/1.1 Installation Guide
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Full Installation Computer Requirements

Full Installation Computer Requirements

Minimum  Table 2 shows the recommended and minimum computer
Configurations configurations for a new full installation (the GeneMapper® ID-X
Software v1.0 or v1.1 and database).

Note: To install the GMID-X software, you need a local user
account with administrative privileges. You can run the computer on
regional settings but you need an English Operating System.

Table 2 Computer requirements for a new full installation

Component Recommended Configuration Minimum Configuration#

IMPORTANT! The GeneMapper® ID-X Software will not function properly on computers with
multiple physical processors. The GeneMapper® ID-X Software requires a single-processor or dual-
core processor computer. It is not advised to install the software on a computer with other Oracle® or
SQLPIus applications and clients, other than the database that is installed with the Data Collection
software. If you must run other applications, install GMID-X first.

Computer ¢ Intel Pentium® IV processor, >2.8 GHz | ¢ Intel Pentium® processor, 733 MHz
e 1GB of RAM e 512 MB of RAM
e Two 120-GB hard drives$
e Free disk space: e Free disk space:

— 200 MB on the boot drive (drive on — 200 MB on the boot drive (drive
which the operating system is on which the operating system is
installed) installed)

— 7 GB on the drive on which the — 7 GB on the drive on which the
GeneMapper ID-X Software is GeneMapper /D-X Software is
installed installed

e 20/48X IDE CD-ROM e 20/48X IDE CD-ROM
e 10/100 NIC with RWU (internal) e 10/100 NIC with RWU (internal)
Monitor e 1024 x 768 pixel resolution e 1024 x 768 pixel resolution
¢ 19-inch color monitor (enables greater = ¢ 17-inch color monitor
viewing of data)

GeneMapper® ID-X Software v1.0/1.1 Installation Guide 9



m Chapter 2 Installation Requirements
Full Installation Computer Requirements

Table 2 Computer requirements for a new full installation (continued)

Component Recommended Configuration Minimum Configuration®*
Operating Either of the following:
System

¢ Microsoft® Windows® 2000 Professional Operating System, Service Pack 4
Update

¢ Microsoft® Windows® XP Professional Operating System, Service Pack 2 or later

Note: The GMID-X software is not supported on the Microsoft® Windows® 2003
Operating System and has not been tested on the Windows® Vista® Operating
System. Additionally, operating system requirements for co-installation (installation
on a Data Collection computer) may differ from those listed above. For information,
see “Analyzers and Compatible Software” on page 14.

Ethernet ¢ Network card for database installation

Capability * TCP/IP must be installed before database installation

F¥ The minimum configuration may not provide optimal performance.
§ Required if the Data Collection Software and the GeneMapper® ID-X Software are installed on the same
computer.

Note: Intel® Core™ 2 Duo processors ship as standard with many computers. The GMID-X
software has been validated by Applied Biosystems to run on Intel® Core™ 2 Duo processor
computers.

Required Time for The amount of time required to perform a full installation is:

Full Installation * Approximately 1 hour on a non-data collection computer,
depending on the speed of the computer.

* Approximately 25 minutes on a Data Collection computer
(340 SCSI).

* Approximately 1 hour 15 minutes on other Data Collection
computers.

10 GeneMapper® [D-X Software v1.0/1.1 Installation Guide
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Client Installation Computer Requirements

Client Installation Computer Requirements

Minimum  Table 3 shows the minimum computer configurations for a client
Configurations installation (GeneMapper® ID-X Software v1.0 or v1.1 only).

Note: To log in to the GMID-X software, you need a local user

account with administrative privileges. For sites outside the U.S., you
may need to change regional settings to U.S. settings following
software installation.

Table 3 Computer requirements for client installation

Component

Minimum Configuration

Client
Computer

Monitor

Operating
System

Intel Pentium® processor, 733 MHz
512 MB of RAM*

20/48X IDE CD-ROM drive

10/100 NIC with RWU (internal)
250 MB of free disk space

200 MB on the boot drive (drive on which the
operating system is installed)

1024 x 768 pixel resolution

17-inch color monitor (smaller monitor lessens ability
to view a full screen of data)

Either of the following:

Microsoft® Windows® 2000 Professional
Operating System, Service Pack 4

Microsoft® Windows® XP Professional Operating
System, Service Pack 2 or later

Note: The GMID-X software is not supported on the
Microsoft® Windows® 2003 Operating System and has
not been tested on the Windows® Vista® Operating
System.

I Although you can install the GeneMapper ID-X Software on a computer
with 512 MB of RAM, Applied Biosystems recommends using 1 GB or
more of RAM for better performance.

GeneMapper® ID-X Software v1.0/1.1 Installation Guide 11
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Client Installation Computer Requirements

Required Time for The amount of time required to perform a client installation is
Client Installation approximately 5 to 10 minutes.

Optimizing For recommendations on the number of client connections to use per
Computer host to optimize computer performance, contact Applied
Performance Biosystems.

12 GeneMapper® [D-X Software v1.0/1.1 Installation Guide
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Verifying Your Computer Setup

Verifying Your Computer Setup

1. On the desktop, right-click -_g{j My Computer, then select
Properties.

2. Click the General tab of the System Properties dialog box to
verify that your computer meets the minimum requirements for

installation.
System Restore I Automatic Updates I Femote I
General | Computer Mame I Hardware I Advanced
. Operating
Microsoft Windows xP ‘ SyStem (OS)
Profeszional .
. 'U Version 2002 OS version
u[ 1 Service Pack 2
/
- Registered to: Latest Service

GeneMagper [D-X Pack installed

Computer:

IntellF) 1 Microprocessor

Pentiurn(R] 4 CPU 2.40GHz g
28 GHz 1.00GE of RaM type and Speed

[ Installed memory

QK I Cancel Apply

GeneMapper® ID-X Software v1.0/1.1 Installation Guide 13
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Analyzers and Compatible Software

Analyzers and Compatible Software

Instrumentation Table 4 lists Applied Biosystems Genetic Analyzer instruments and
the corresponding Data Collection and Operating system software
that are supported by the GeneMapper® ID-X Software

Table 4 Genetic Analyzers and Compatible Software

Data Collection Software and

Genetic Analysis Instrument Operating System

e 310 Data Collection v3.0
' ¢ Windows 2000, SP 3 and 4
gm= ABIPRISM®310 and
E Genetic Analyzer
| e 310 Data Collection v3.1
e Windows XP, SP 2 or later
. . ¢ 3130 Data Collection v3.0/
E j. Applied Biosystems 3130x/ Data Collection v3.0

3130/3130x/ e Windows XP, SP 2 or later
Genetic Analyzer

'« 3100 Data Collection v2.0/

ABI PrisM® 3100/3100- 3100-Avant™ Data
H\J Avant™ Genetic Collection v2.0
Analyzer e Windows 2000, SP 3 or

later
'« 3730 Data Collection v3.0

)
| | Applied Biosystems * Windows XP, SP 2 or later
; 3730 Genetic Analyzer¥

F The 3730 Genetic Analyzer does not include the 3730x/ 96-capillary
configuration. The 48-capillary configuration is validated for analysis of
Identifiler® data generated from single-source data samples only.
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Overview
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Reminders

This chapter provides procedures that you must perform to install
GeneMapper® ID-X Software v1.0 or v1.1 software on computers
that have GeneMapper® ID Software v3.x currently installed. It also
provides the procedure for upgrading from GeneMapper® ID-X
Software v1.0 or v1.0.1 to v1.1.

IMPORTANT! If you are installing GMID-X v1.0 or v1.1 software
on a computer without GMID v3.x, proceed to Chapter 4 on page 33
for full installation instructions or Chapter 5 on page page 43 for
client installation instructions.

IMPORTANT! If you are upgrading from GMID-X v1.0/1.0.1 to
vl.1, go to “Requirements for Upgrading GMID-X v1.0/1.0.1 to
GMID-X v1.1” on page 31 of this chapter.

Before installing GMID-X software on computers that have

GMID v3.x software installed, you must export the data objects
(projects, analysis methods, etc.) as a means of backing up the data,
then uninstall the existing software. Because data objects are deleted
when GMID 3 .x is uninstalled, if they are not exported and saved to a
different location, they cannot be restored.

The GeneMapper® ID-X Software Version 1.0 (or Version 1.1) Full
Install CD contains a GMID v3.2.x Software Export Utility, which
automatically exports all data objects stored within your

GMID v3.2.x database and stores the files in a user-defined location.
This utility is only designed to work in conjunction with GMID v3.2
and above. Therefore, if you are still running GMID v3.1 software,
upgrade to GMID v3.2 to take advantage of this export utility (see
“Requirements for Upgrading GMID v3.1 to GMID v3.2” on

page 18).
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Upgrade to GMID v3.2 if you also wish to import the exported files
into GMID-X v1.0 or v1.1 once the software is installed, and if you
plan to install the full version of GMID-X v1.0 or v1.1 on a 31xx
Data Collection computer.

Note: GMID v3.2.x data objects may be imported and viewed in
GMID-X v1.0 or v1.1; however, their use is limited. (See
“Optimizing Data Sharing” on page 83).
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Requirements for Upgrading GMID v3.1 to

GMID v3.2

To upgrade from GMID v3.1 to GMID v3.2, you must have a
GeneMapper® ID Software v3.2 Installation CD and a valid

GMID v3.1 registration code. If you do not have one or both of these
items, please contact your local technical support organization.

Exporting GMID v3.2.x Data

18

To export data, you can use the Export Utility to automatically export
all data objects from the GeneMapper Manager and Panel Manager
within the GeneMapper® ID Software v3.2.x application.
Alternatively, you can export each data object manually.

Applied Biosystems recommends that you use the Export Utility to
more efficiently export data. Once the data is exported and saved to a
new location, archive these objects using your lab's standard
procedure.
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Using the Export Utility (GMID v3.2.x Software Only)

Exporting 1. Insert the GeneMapper® ID-X Software Version 1.0 (or Version
GMID v3.2.x Data 1.1) Full Install CD into the CD drive.
with Utility Tool
On the splash screen, click Export Data from GeneMapper
ID v3.2 or 3.2.1.

Note: If there is no GMID v3.2 on the target system, the export
button is disabled.

A GeneMapper® ID-X v1.0

[l — L / = ' . i
v WM‘J ,§Qg; I.\Veglgwnsg.sle 5 o N _ A‘Bmﬁlzm
FE L e .

nitiate & service cal

+

GeneMapper®

amn Menu

About Genetappers [0+

Expart D ata from GeneMapper ID 3.2 ar
3.2.1
Install GeneMapper® 10X Application

@ 18%8-2007 Applied Biosystams. All rights reserved.
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3. When the Export tool window is displayed, click Browse to
specify the location to save all exported files, or enter a
destination folder in the field provided:

% GeneMapper ID 3.2x Export Tool

Genehdapper ID 3 .2x Export Tool will export your existing data into the destination folder specified below .

FPlease enter your destination folder

C:Iabapps‘tgmidx’LAppliedEliusystems| | ’ Browse ]

IMPORTANT! Choose an export location outside the
Applied Biosystems » GeneMapper application folder. The
GeneMapper folder is deleted when GMID v3.x is uninstalled.

4. Click Export.

* [f the utility detects a conflict with the location specified,
an error message is displayed. Follow the instructions
given in the error messages before proceeding. These error
messages include:

—No destination is specified for export files. Please select
a destination.

—Specified location does not exist. Please select a new
location.

—Access to specified location denied. Please check folder
permissions or select a new location.

—You have chosen to export data to the
Applied Biosystems » GeneMapper application
folder. This folder is deleted when GMID 3.2 is
uninstalled. Select a location outside of the
Applied Biosystems » GeneMapper application
folder.
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 If the export is successful the following message is
displayed:

Export Complete

@ All GMID 3.2 projects and analysis files were successiully exported to <ClabappsigmitdiApplisdBiosystems=

Ifyou wish to install GMID-X on & non-DC computer or 310 DC cornputar, you must first uninstall GMID 3.2 software.
Uninstallation of GMID 3.2 software must be petformed through AddiRemove Programs found in the Control Panel
Ifyou wish to install GMID-X on a 313 DC computer, you may proceed directly to installation.

 If the export is only partially successful, the following
message is displayed:

Export Errors

@ One or more data objects failed to expart to =ClabappsiamiddAppliedBiosystems = Would you like to view the log file for details?

Proceed to the log file and manually export all data objects
that failed to export.

After you have exported all your files, review the following table to
determine the steps to take next.

Table 5 Installation Options following Auto Export

Computer

Type Full Installation Client Installation
1. Uninstall GMID v3.x. 1. Uninstall GMID v3.x.

See “Uninstalling the See “Uninstalling the
GMID v3.x Software” GMID v3.x Software”

Non-DC or on page 24. on page 24.

310DC 2. Install Full GMID-X 2. Install Client GMID-X

Computer v1.0 or v1.1. See v1.0 or v1.1. See
“Performing a Full “Performing a Client
Installation” on Installation” on
page 36. page 46.
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Client Installation

Exporting GMID v3.2.x Data
Computer .
Type Full Installation
Do not uninstall.
31xx or 3730

DC Computer = [Install Full GMID-X v1.0
or v1.1. See “Performing
a Full Installation” on
page 36.

GeneMapper® ID-X Software v1.0/1.1 Installation Guide

. Uninstall GMID v3.x.

See “Uninstalling the
GMID v3.x Software”
on page 24.

. Install Client GMID-X

v1.0 or v1.1. See
“Performing a Client
Installation” on
page 46.
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Manually Exporting GMID v3.2 Data Objects

For information on manually exporting files out of GMID v3.x, refer
to the section on exporting items from GMID Manager in the
GeneMapper® ID Software Version 3.1 User's Guide.

After you have exported all your files, review the following table to
determine the steps to take next.

Table 6

Installation options following manual export

Computer
Type

Full Installation

Client Installation

Non-DC or
310 DC
Computer

1.

Uninstall GMID v3.x.
See “Uninstalling the
GMID v3.x Software”
on page 24.

Install Full GMID-X
v1.0 or v1.1. See
“Performing a Full
Installation” on
page 36.

. Uninstall GMID v3.x.

See “Uninstalling the
GMID v3.x Software”
on page 24.

. Install Client GMID-X

v1.0 or v1.1. See
“Performing a Client
Installation” on
page 46.

31xx DC
Computer

Do not uninstall.

Install Full GMID-X v1.0
or vi.1. See “Performing
a Full Installation” on
page 36.

. Uninstall GMID v3.x.

See “Uninstalling the
GMID v3.x Software”
on page 24.

. Install Client GMID-X

v1.0 or vi.1. See
“Performing a Client
Installation” on
page 46.
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Uninstalling the GMID v3.x Software

24

IMPORTANT! For 31xx or 3730 Data Collection Full Installations
only: If you are installing the full GeneMapper® ID-X Software v1.0
or vl.1 on a 31xx or 3730 Data Collection Computer, do not
uninstall the GMID v3.x software. The GeneMapper® ID-X Software
v1.0 or v1.1 installer automatically overrides the existing GMID v3.x
software and installs the fill GeneMapper® ID-X Software v1.0 or
vl1.1 for you.

IMPORTANT! For all other installations, you must restart your
computer before uninstalling. If you forget to do so, upon running
the uninstall, the computer prompts you the restart your computer
(click Cancel to exit the uninstall). If you have already restarted your
computer, click OK to continue the uninstall.

Follow the steps below to uninstall GeneMapper® ID Software v3.x:

1. Log in to the computer using a user account with administrative
privileges.

2. Close the GeneMapper® ID Software v3.x and all other
applications, then restart your computer before proceeding with
the uninstall.

IMPORTANT! If you do not restart your computer before
proceeding with the uninstall and/or if the uninstall does not
complete successfully the first time, perform this procedure a
second time. If the uninstall still does not work, have a
knowledgeable technician review and proceed with “Running
the Clean-up Utility” on page 102 or contact Applied
Biosystems Technical Support to proceed.

3. Select Start » Control Panel.

GeneMapper® ID-X Software v1.0/1.1 Installation Guide



Chapter 3 Performing GMID-X v1.0 Pre-Installation and GMID-X v1.1 Upgrade Procedures m
Uninstalling the GMID v3.x Software

4. Double-click Add or Remove Programs.

Note: If a message indicates that you need administrator rights
or privileges, log off the computer, then log on again as a user
with administrator privileges.

Select the GeneMapper® ID Software.

Click Change/Remove. The InstallShield Wizard opens.

In the Welcome page, select Remove, then click Next.

At the prompt, click OK to verify the uninstall.

© © N o o

When the Maintenance Complete window opens, select Yes, 1
want to restart my computer now.

IMPORTANT! For the uninstallation to complete, you must
restart the computer. Do not install GMID-X v1.0 or v1.1
software without first restarting your computer.

IMPORTANT! After you restart your computer, a command
prompt window may be displayed. This window can take up to
40 seconds to close. Do not close this window. Wait for the
process to complete on its own. If you close the window, the
GMID-X software may not install correctly.
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Enabling Autoanalysis

Use autoanalysis if you want to communicate with the Data
Collection software for the collection and processing of .fsa sample
files, and for data analysis.

For installations in which you want autoanalysis enabled, follow the
procedures below:

» Start the Data Collection Software to enable autoanalysis during
the full and client installation procedure (see page 26).

* Retrieve the Data Collection Computer name to enable
autoanalysis during the full and client installation procedure
(see page 29).

* Retrieve the Host Computer name to enable client access to the
host computer during the client installation procedure (see
page 30).

IMPORTANT! The Data Collection software must be running during
installation if you wish to run autoanalysis.

Starting the Data Collection Software on the 31xx Data
Collection Computer

Start the Data
Collection
Software to
Enable
Autoanalysis

26

Start the Data Collection Software on the 31xx Data Collection
computer before installing the full GeneMapper® ID-X Software v1.0
or v1.1 on your computer for a remote autoanalysis configuration, or
on the 31xx Data Collection computer for a co-installation.

Note: For 310 Data Collection Computers only: The following Data
Collection Software sections are not applicable. Proceed to
“Performing a Full Installation” on page 36 or “Performing a Client
Installation” on page 46.
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Starting the Data  Use the following procedure to enable autoanalysis only.

Collection

Software 1-

On the 31xx Data Collection computer, select Start » All
Programs » Applied Biosystems » Data Collection » Run
<Data Collection version>, where <Data Collection version>
is:

* 3100/3100-Avant™ Data Collection v2.0,
or
* 3130/3130x/ Data Collection v3.0.

After the Service Console opens, wait until all four symbols
change to green squares .

Service Console Service Console

Messaging Service / Messaging Service

Data Service O Data Service
Instrumert Service O Instrumert Service
Wievver O Wievver

| |

Note: If the software services do not start automatically, click
Start All.

If the Data Collection Software requires a password, a login
dialog box opens. Enter the Login Name and Password, then
click OK.

Note: If you do not know the Data Collection computer Login
Name or Password, contact your Data Collection computer
administrator.
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4. Verify that the Data Collection software started without errors:

a. In the Service Console, right-click the square next to Data
Service, then select Show Console to display the Data
Service output message box.

E] Service Console IZI@EI

Messaging Service

———— Right-click here

Data Service

Stop

Instrumert Service

Wievver

|

b. Verify that no errors are displayed in the lower pane of the
message box, then close the Data Service output message

box.
< Data Service output @
[INFO,Default] 10:59:33.843 Found disk space for driwe Gi = 1%

[INFO,Default] gerCurrentStatusTypes. ..
[INFO,Default] 10:§9:35.718 For testing only: ICFGetNManualCont
[INFO,Default] 3130, instrumentTypeName= ga3l00-Avant
[INFO,Default] getCurrentStatusTypes...

[INFO,Default] 10:59:36.562 VARNING: Mo walid spatial calibrat.,

< | >

No errors
displayed
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Obtaining the Data Collection Computer Name

If you are installing the client GeneMapper® ID-X Software v1.0 or
v1.1 on a non-Data Collection Computer to enable remote
autoanalysis, you must first obtain the name of the 31xx Data
Collection computer:

1. On the 31xx Data Collection Computer, right-click My
Computer, select Properties, then select the Computer Name
tab to view the full computer name.

System Properties E| g|

System Restore Automatic Updates Femote
General Camputer Hame Hardware Advanced
'_1-1 Windows uses the following information to identify your computer
on the network.

Computer description:

For example: "Kitchen Computer or "Mary's

Computer". Com puter
Full computer name: Genebapper ID-¥ name
workgroup: WORKGROUP

To use the Metwark |dentification Wizard ta join a Metwork |0
domain and create a local uzer account, click Metwork

0.

To rename this computer of join a domain, click Change.

[ Ok H Cancel ]

2. Make a note of the computer name and enter this name when
prompted during installation of the client GeneMapper® ID-X
Software.
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Obtaining the GeneMapper® ID-X Software Host
Computer Name

Before you install the client GeneMapper® ID-X Software, obtain the
name of the multi-user database host computer to enable access to
the host computer from a network:

1. On the multiuser database host computer, right-click My
Computer, select Properties, then select the Computer Name
tab.

System Properties

System Restore Automatic Updates Femote
General Camputer Hame Hardware Advanced
7;1 Windows uses the following information to identify your computer
on the network.

Computer description:

For example: "Kitchen Computer or "Mary's

Computer.
Full computer name: Genebapper ID-¥ Computer
‘workgroup: WORKGROUP name
To uge the Metwork, [dentification \Wizard to join a
domain and create a local user account, click MNetwaork et
0.

To rename this computer of join a domain, click Change.

[ Ok H Cancel ]

2. Make a note of the computer name and enter this name when
prompted during installation of the client GeneMapper® ID-X
Software.
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Requirements for Upgrading GMID-X v1.0/1.0.1 to
GMID-X v1.1

To upgrade your target computer (client or full) to v1.1, make certain
that either GMID-X v1.0 or v1.0.1 is already installed on your
system. The upgrade installer works only if it detects either of these
previous versions.

IMPORTANT! When you upgrade on a client computer, you must
also upgrade the computer that hosts the full software version on the
same local area network.

Note: You can reuse your existing password when upgrading from
GMID-X v1.0 or v1.0.1 to v1.1.

To upgrade from GMID-X v1.0 or v1.0.1 to v1.1:

1. Insert the GeneMapper® ID-X Software Version 1.1 Upgrade
Install CD into your CD drive.

2. In the Welcome Window, click Next.
3. Read the Release notes, then click Next.

4. Click Next to install the Software to the default location.
or

To install the GeneMapper® ID-X Software to a drive different
from the default drive, select the destination folder.

5. When the software is installed, remove the installation CD from
the CD drive.

The upgrade installation takes approximately 5 to 10 minutes,
depending on the computer being upgraded.
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Overview

Overview

This chapter describes how to perform a full installation of the
GeneMapper® ID-X Software Version 1.0 or Version 1.1 (GMID-X
v1.0 or v1.1) on your target computer.

Note: If you have GeneMapper® ID Software v3.x (GMID v3.x) on
your computer and haven’t already performed pre-installation tasks,
go back to Chapter 3, “Performing GMID-X v1.0 Pre-Installation
and GMID-X v1.1 Upgrade Procedures,” on page 15 for additional
instructions. The installation may fail if these tasks are not
performed first.

User Account Requirements for Full Installations

34

Log On
Requirements

Verifying User
Accounts

To perform a new full installation of GMID-X v1.0 or v1.1, you
must:

* Log on to the local computer (not a network domain).
» Use an Administrator account (unrestricted access).

Note: After the software is installed, you can run the GMID-X v1.0
or v1l.1 without using an Administrator account.

1. On the desktop, select Start » Control Panel.
2. In the Control Panel window, double-click User Accounts.

3. In the Users tab, verify that the user account belongs to the
Administrators group and the domain name is the same as the
computer name.
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User, swccounts

Users | Advanced |

Use the list below to grant or deny users access to your
computer, and ko change passwords and other settings,

Users For this computer:

User Mame Daomain (Grouy L]
Ik £ fdrmini ar ]
lgGuest D4EBPF351 Guests | ¥ | Be|ongs to the
Administrators

Domain is the
<) same as the
Add... ] [ Remove ] [ Properties ] CompUter name

Password for Administrator

g Ta change the password For Administrator, click Reset

Password,
Reset Password. ..

OF H Cancel ] Apply
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Performing a Full Installation

A full GeneMapper® ID-X Software v1.0 or v1.1 installation:
* Installs the GMID-X software and database.

* Enables the GMID-X v1.0 or v1.1 software to serve as the host
for multiple client computers needing access to the database.

Note: It is not recommended that the Data Collection computer
function as the host computer due to performance constraints.

Full Installation Requirements

Important Below is a list of items to take into consideration prior to installing
Reminders GMID-X v1.0 or v1.1.

* DO NOT cancel an installation before the installation process is
finished. If you do so, or if the installation otherwise stalls, you
may need technical support to perform an uninstall. To uninstall
your installation, see “Uninstalling the GMID-X Software” on
page 100. If uninstallation fails, contact your local Applied
Biosystems technical support organization.

* In a co-installation (Data Collection computer with Data
Collection Software), you are limited to one client connection.
To allow more client connections to the database, install the full
version GeneMapper® ID-X Software (software and database)
on a computer other than the Data Collection (DC) computer.

A full installation on a 31xx DC Computer is only possible if
the DC Computer is running DC Software v2.0 or higher.

* When installing GMID-X v1.0 or v1.1 on a 31xx DC Computer
that has GMID v3.2 software, you do not need to uninstall the
v3.2 software; however, you must recreate all the files
associated with autoanalysis (e.g. Results Groups) because old
files created as part of the GMID v3.2 integration cannot be
reused. See Chapter 7, “Setting Up Autoanalysis.”
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* When you install GMID-X v1.0 or vl.1 on a 31xx DC
Computer or on a non-DC computer (computer without the
Data Collection software) for remote autoanalysis, the data
collection software must be running on the DC Computer. For
more information on starting the data collection software, see
page 26.

» To set up autoanalysis, obtain the computer name of the DC
Computer: Right-click My Computer on the DC computer,
select Properties, then select the Computer Name tab to view
and record the full computer name. You are required to enter
this during installation (see page 29).

Installing the Full GeneMapper® ID-X Software

Full Installation To install the full GMID-X v1.0 or v1.1 software onto your
Procedure computer:
(DC and Non-DC 1

. Insert the first disk of the GeneMapper® ID-X Software Version
Computers) PP /!

1.0 (or vI.1) Full Install CDs into the CD drive (if not inserted
during use of the Export Utility).

2. On the splash screen, double-click Install GeneMapper ID-X
v1.0 (or v1.1) Application to start the installer.

3. Close all other applications and windows (except the Data
Collection application), then click OK to close the following
message.

GeneMappen® ID-X

\!:) Close all running applications before proceeding with the installation,

4. In the Welcome window, click Next.

5. Review the installation requirements status, then click Next.
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6. Select Remote Autoanalysis or Stand-alone for type of
installation, then click Next:

* Remote Autoanalysis — Select this option to set up remote
autoanalysis. In this configuration, the target computer is
networked to the 31xx DC computer. The autoanalysis
manager alerts GMID-X when a run is complete. GMID-X
then opens, and you can import the .fsa files into a project
and analyze them.

» Stand-Alone — Select this option if you do not want to set
up remote autoanalysis or if your DC computer is not
networked to the target computer during installation.

IMPORTANT! After the GMID-X v1.0 or v1.1 Software is
installed, you cannot switch from stand-alone to remote
autoanalysis. To change the configuration, you must
uninstall, then reinstall the software.

Note: For the 31xx Data Collection computer, you do not
have the option of selecting stand-alone or remote
autoanalysis. You can optionally set up local autoanalysis
later. See “Setting Up Autoanalysis” on page 68 for
instructions.

Note: For the 310 Data Collection Computer, autoanalysis
(local or remote) is not available. Proceed to step 8.

Note: If you select Stand-alone, skip step 7 and step 13.
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GeneMapper® ID-X

Setup Type
Chooze the setup type that best suits your needs.

Femote auto-analysiz option will install the auto-analysiz manager utility
| to automatically analyze data collected from D ata Collection spstem. IF

you don't have a Data Collection spstem available, you should choose
stand-alone option.

(®) Stand-alone
() Remate Autoanalysis [networked to the instrument computer]

DX

BB eyt

[ < Back " Mext > |[ Cancel ]

7. (Remote Autoanalysis only) If you select Remote Autoanalysis,
enter the full name of the Data Collection computer that you
intend to have support remote autoanalysis (see page 29), then
click Next.

GeneMapper® ID-X

Enter Text

Please enter information in the figld below.

Provide a valid Data Collection spstem name below. If you don't have a Data Collection system
already available, go back to the previous screen and choose a stand-alone installation
instead.

[ < Back " Mext > ][ Cancel

8. Read the release notes, then click Next.
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9. Click Next to install the Software to the default location. To
install the GeneMapper® ID-X Software to a drive different
from the default drive, select the destination folder:

a. Verify that the boot drive (drive on which the Windows
operating system is installed) contains at least 200 MB of
available free space.

b. Select a destination folder with at least 7 GB of free space,
then click Next.

IMPORTANT! If you choose an invalid destination such as
A: drive or CD-DVD ROM and click Next, an error
message is displayed saying the drive is invalid. When you
click OK the installation is stopped. To recover, click
Cancel and start the installation over again, using a valid
destination folder.

GeneMapper® ID-X

Choose Destination Location

Select folder where setup will install files, | h

Setup will inztall Genet apper® 10+ +1.0 in the following folder. Tao ingtall it in this folder,
click Mext. Toinstall it in a different folder, click Browse and navigate to the folder in which
you want ta ingtall the Genetapper® |D-x 1.0 software.

Destination Folder

C:\AppliedBiosystemsh

< Back " Mext > ][ Cancel ]
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10. Select a Setup Type if desired: either Desktop Short Cut and/or
Quick Launcher or deselect both, then click Next.

GeneMapper® ID-X

Setup Type
Choose the setup type that best suits your needs.

Inztaller will create following short cuts, if you do nat wish to create
L | them, please uncheck, them.

Desktop Shart Cut
Quick Launcher

GeneMapper®

[ < Back " Mext » ][ Cancel ]

11. Read the current settings, then click Next to start the
installation.

IMPORTANT! During installation, a DOS window may open
while DOS commands execute. Do not delete, close, or click the
DOS window. If you accidentally click the DOS window, press
the Esc key to exit the window.

12. When prompted, insert Disk 2 and follow instructions.
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13. (Remote Autoanalysis only) When GeneMapper® ID-X
Software installation is complete, if you were running the Data
Collection Software, stop the software on the 31xx Data
Collection computer by clicking Stop All in the Service
Console.

Service Console

Messaging Service

Data Service

Instrument Service

Wievver

14. Remove the installation CD from the CD drive.

15. Inthe InstallShield Wizard Complete page, select Yes, I want to
restart my computer now, then click Finish.

When you finish the installation, proceed to Chapter 6, “Performing
Post-Installation Procedures,” on page 53.

To set up autoanalysis after performing post-installation procedures,
proceed to Chapter 7, “Setting Up Autoanalysis,” on page 61.
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Overview

This chapter describes how to perform a client installation of the
GeneMapper® ID-X Software Version 1.0 or Version 1.1 on your
target computer.

Note: Ifyou have GeneMapper® ID Software v3.x on your computer
and haven’t already performed pre-installation tasks, go back to
Chapter 3, “Performing GMID-X v1.0 Pre-Installation and GMID-X
v1.1 Upgrade Procedures,” on page 15 for additional instructions.
The installation may fail if these tasks are not performed first.

User Account Requirements for Client Installations

Log In To perform a client installation of the GeneMapper® ID-X Software:

Requirements » Confirm that the target computer is connected to the database
host computer when you log in. If there is no login window that
connects you to the local area network served by the host, or if
you are not automatically connected, contact your lab’s on-site
technical support department.

* Use an Administrator account (unrestricted access).

Note: After the software is installed, you can run the GeneMapper®
ID-X Software without using an Administrator account.

Verifying User 1. On the desktop, select Start » Control Panel.

Accounts
2. In the Control Panel window, double-click User Accounts.

3. In the Users tab, verify that the user account belongs to the
Administrators group and the domain name is the same as the
computer name.
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User, swccounts

Users | Advanced |

Use the list below to grant or deny users access to your
computer, and ko change passwords and other settings,

Users For this computer:

User Mame Domain Group A
I i Administratar ]
lgGuest D4EBPF351 Guests | ¥ |

A
Add... ] [ Remove ] [ Properties ]

Password for Administrator

g Ta change the password For Administrator, click Reset

Password,
Reset Password. ..

OF H Cancel ] Apply
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Performing a Client Installation

A client GeneMapper® ID-X Software v1.0 or v1.1 installation:

Allows the user access to the GMID-X v1.0 or v1.1 software
without a database installed on the same computer.

Connects to one or more database hosts for access to the data
stored in the database and saves data objects back to the
database.

Client Installation Requirements

46

Important Below is a list of items to take into consideration before you perform
Reminders a client installation:

DO NOT cancel an installation before the installation process is
finished. If you do so, or if the installation otherwise stalls, you
may need technical support to perform an uninstall. To uninstall
your installation, see “Uninstalling the GMID-X Software” on
page 100. If uninstallation fails, contact your local Applied
Biosystems technical support organization.

At least one full installation must be performed on another
computer for it to act as the database host for the client.

Users are required to have a valid user name and password with
an account on the database host computer.

You must obtain the name of the database host computer to
enable access to the host computer from a network: Right-click
My Computer on the database host computer, select
Properties, then select the Computer Name tab to view and
record the full computer name. You are required to enter this
name during installation (see page 30).

When you install GMID-X v1.0 or v1.1 on a 31xx Data
Collection computer or on a non-DC computer for remote
autoanalysis, the data collection software must be running on
the Data Collection computer (see page 26.)
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» Ifyou choose to set up autoanalysis, obtain the Computer Name
of the Data Collection computer: Right-click My Computer on
the Data Collection computer, select Properties, then select the
Computer Name tab to view and record the full computer
name. You are required to enter this during installation (see
page 29).

Installing the Client GeneMapper® ID-X Software

To install the client GeneMapper® ID-X Software Version 1.0 or
Version 1.1 on the target computer:

1. Insert the GeneMapper® ID-X Software Version 1.0 (or Version
1.1) Client Install CD into the CD drive.

2. On the splash screen, double-click Install GeneMapper ID-X
v1.0 (or v1.1) Client to start the installer.

3. Be sure that the Data Collection software application is running
but close all other applications and windows, then click OK to
close the following message.

GeneMapper® ID-X Client

\‘_I{) Before proceeding with installation, close all running applications and their windows,

4. In the Welcome window, click Next.
5. Review the installation requirements status, then click Next.

6. Read the release notes, then click Next.
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7. When prompted, enter the GeneMapper® ID-X Software (GM)
host (server) computer name, then click Next.

GeneMapper® ID-X Client

Enter Text

Please enter information in the field below.

Provide a wald Genetd apper® 1D-< Database Mame below. If you don't have the

Genet apper® |D-< Database installed pet, You can still proceed with the client installation
and install the server later. Genetdapper® |D-< Client requires a valid Genebdapper® 10+
[atabaze in order ta function properly.

’ < Back " Wet > ][ Cancel ]

8. After the installer establishes a connection with the multi-user
database computer, click OK to continue.

GeneMapper® ID-X v1.0 Client - InstallShield Wizard ﬁ__(|

1 ) Server connection established,

9. Select Remote Autoanalysis or Stand-Alone for type of
installation, then click Next.

* Remote Autoanalysis — Select this option to set up remote
autoanalysis. In this configuration, the target computer is
networked to the 31xx Data Collection computer. The
autoanalysis manager alerts GMID-X when a run is
complete. GMID-X then opens, and you can import the
.fsa files into a project and analyze them.
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» Stand-Alone — Select this option if you do not want to set
up remote autoanalysis or if your DC computer is not
networked to the target computer during installation.

IMPORTANT! After the GMID-X v1.0 or v1.1 Software is
installed, you cannot switch from stand-alone to remote
autoanalysis. To change the configuration, you must
uninstall, then reinstall the software.

Note: For the 31xx Data Collection computer, you do not
have the option of selecting stand-alone or remote
autoanalysis. You can optionally set up local autoanalysis
later. See “Setting Up Autoanalysis” on page 68 for
instructions.

Note: For the 310 Data Collection Computer, autoanalysis
(local or remote) is not available. Proceed to step 11.

Note: If you select Stand-alone, skip step 10 and step 13.

GeneMapper® ID-X Client &|

Setup Type
Select the zetup type that best zuits your needs.

Remate auto-analyziz option will install the auto-analysis manager utility
4 to automatically analyze data collected from Data Collection system. |f
you dan't have a Data Collection system available, you should chooze
stanid i

() Remate Autnanalysis [netwarked to the instument computer]

GeneMapper®

ID-X

[T

< Back " Mest » l[ Cancel
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10. (Remote Autoanalysis) If you selected Remote Autoanalysis,
enter the full name of the 31xx Data Collection computer that
will support the remote autoanalysis configuration, then click
Next.

GeneMapper® ID-X Client

Enter Text
Please enter information in the figld below. |

Provide a valid Data Collection spstem name below. If you don't have a Data Collection system
already available, go back to the previous screen and choose a stand-alone installation
instead.

[ < Back " Mext > ][ Cancel ]

11. To install the GeneMapper® ID-X Software to a drive on the
client computer other than the default drive, select the
destination folder and verify that the boot drive (drive on which
the Windows operating system is installed) contains at least
250 MB of available free space.

IMPORTANT! If you choose an invalid destination such as A:
drive or CD-DVD ROM and click Next, an error message is
displayed saying the drive is invalid. When you click OK the
installation is stopped. To recover, click Cancel and start the
installation over again, using a valid destination folder.
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Chapter 5 Performing a Client Software Installation
Performing a Client Installation

GeneMapper® ID-X Client

Choose Destination Location

Select folder where zetup will ingtall files, | h

Setup will install Genebd apper® |0+ Client in the follawing folder.
Ta inztall it in this folder, click Next. To install it in a different folder, click Browse and
navigate to the folder in which you want to install the Genetd apper® |D-+ Client.

Destination Folder

C:\AppliedBiosystems'

[ < Back " Mext > ][ Cancel ]

Read the current settings, then click Next to start the
installation.

IMPORTANT! During installation, a DOS window may open
while DOS commands execute. Do not delete, close, or click the
DOS window. If you accidentally click the DOS window, press
the Esc key to exit the window.

When installation of the GeneMapper® ID-X Software is
complete, if you had the 31xx Data Collection Software
running, stop the software on the Data Collection computer by
clicking Stop All in the Service Console.

Remove the installation CD from the CD drive.

In the InstallShield Wizard Complete window, select Yes, I
want to restart my computer now, then click Finish.

Repeat the procedure for additional client installations.

When you finish all client installations, proceed to Chapter 6,
“Performing Post-Installation Procedures,” on page 53.

To set up autoanalysis after performing post-installation procedures,
proceed to Chapter 7, “Setting Up Autoanalysis,” on page 61.
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Resetting Permissions for the Installation

Resetting
Permissions on
Folders and Files

52

The client installer specifies folder privileges at the time of the
GeneMapper® ID-X Software installation.

However, the NTFS permissions set by the system administrator may
not allow the GeneMapper® ID-X Software to access the
GeneMapper folder following installation. Before you run the
software, check the permissions to make sure that the GeneMapper®
ID-X Software can access the GeneMapper folder.

If you do not have the required permissions, you may see a “can't
access file” error message when using the software. To set the
privileges manually, either before running the software or in the
event of an error message:

1. Right-click the AppliedBiosystems folder.
2. Select Properties, then click the Security tab.
3. In the top pane, select Users.

4. In the bottom pane, select Full Control.

AppliedBiosystems Properties 2IX
General | Sharing | Secuity | Custamize

é[UJD or Uzer names:
ﬂ Adminizhatos [FOSYENKATRMDO3Mddministra:ors|
€5 rIFATNR NuwAFR
€7 vsTEM
ﬂ Users [FOSYENKATRHD O3 seis)

Pernistions for Urers Al beng
Full Lorirol O =
Modfy ] Pl
Read & Executs O
List Folcer Corvents 1
Rerad O
O

Wits

JEIT . T

v

“un wpetial pe missions O o advarce. selings, Adeancec
lics Advanced. = .

ok [ camsl [ apy |
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Registering the GeneMapper® ID-X Software

Register the GeneMapper® ID-X Software v1.0 or v1.1 the first time
you start the software on each computer. The registration code is on
the registration card packaged with the software.

Note: If you upgraded from GeneMapper® ID-X Software
v1.0/v1.0.1 to v1.1, you do not need to re-register. Your registration
code remains the same.

Enter the same registration code on each computer, based on the
number of users each registration code supports.

1. On the desktop, double-click 2 GeneMapper ID-X v1.0 (or

g0

v1.1) or select Start » All Programs » Applied Biosystems »
GeneMapper » GeneMapper ID-X v1.0 (or v1.1).

2. Complete the Registration dialog box:

& GeneMapper @

Product Redistration

Gt

3. Click OK.
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Logging Into GMID-X After Installation

1. Ifthe Login dialog box is not displayed in the desktop,

double-click ‘f GeneMapper ID-X v1.0 (or v1.1) or

select Start » All Programs » Applied Biosystems »
GeneMapper » GeneMapper ID-X v1.0 (or v1.1).

2. In the Login to GeneMapper /D-X dialog box, enter or select
“gmidx” as the administrator account user name and the
temporary password, “password”, then click OK:

v Login to GeneMapper® ID-X

User Mame :gmidx v_|
. Password: | MMM| |
GonoMapper®
Database Host: |d0gespa\ace v|
@ 1999-2007 Applied Biosystems. All Rights Resened.
[ e Host, ., ] [ Delete Hogt ] [ Default Host ] [ 0K ] [ Exit I l Help ]

3. If prompted, specify a new password. Keep a record of the new
password. Click OK.

Note: The gmidx account requires you to set a new password
when you log in for the first time. If you follow this procedure
after first log in, the passwords for the accounts listed may be
different from the passwords listed in this guide.

IMPORTANT! Do not lose the password for the gmidx account.
Applied Biosystems cannot retrieve these passwords.

4. Read the license agreement, then click Yes if you agree with the
terms.

5. Review the license agreement and product warranty, then click
Accept.
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Connecting to a New Host

If you install more than one multi-user database computer, any client
computer can connect to any of the databases if the client is on the
same network as the database computers.

Users must set up separate user accounts on each multi-user database
computer that they wish to access.

Note: For detailed information on setting up user accounts, see the
GeneMapper® ID-X Software Version 1.0 Administrator’s Guide.

To make the multi-user database computers available to client
computers, perform the following steps for each client computer:

1. Click New Host in the Login to GeneMapper /D-X dialog box.

o Login to GeneMapper® ID-X

User Mame :!gmidx v|

Password: | HHH| |
GeneMapper®

D ) Database Host: | dogespalace v |

@ 1999-2007 Applied Biosystems. All Rights Ressrved

( mew Host... )[ DekteHost | [ Defautthost | [ ok [ Eat |[ Hew |

2. Complete the information in the New Host dialog box:

Enter new GeneMapper host information:

Cancel
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Connecting to a New Host

a. In the Host Name field, enter the full computer name or
IP address of the multi-user database host you want to
access. If the GeneMapper® ID-X Software cannot connect
to the database host, the error message “You have entered
an invalid host” is displayed. Click OK to exit, then re-
enter the database host information.

b. Select the applicable machine type.
c. Click OK.

The Login window is updated to include the name of the new
database host. The User Name list reflects the user accounts on
the new database host. See the GeneMapper® ID-X Software
Version 1.0 Administrator’s Guide for additional information.
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Logging Out of the GeneMapper® ID-X Software

58

You can close the GeneMapper® ID-X Software by:

» Selecting File » Logout.

* Selecting File » Exit.

* Clicking E3 (Close).
When you log out of the GeneMapper® ID-X Software with a project
that has unsaved changes, the software prompts you to save or

discard the changes you made since the last time you updated the
project.

Save Project

& Do wou want bo sawe changes?

[ es ][ Ho ][Cancel]

If you used the File » Logout command, the login window re-opens
after you select either Yes or No. The GeneMapper /D-X Software
closes completely if you use either File » Exit or 3 (Close).
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Additional Post-Installation Tasks

Importing
Application Data

Creating User
Accounts and
Configuring
Administrative
Functions

Setting Up
Autoanalysis

If you exported application data from GeneMapper® ID Software
v3.2.x before you installed GeneMapper® ID-X Software v1.0 or
v1.1, you may wish to import the data objects (projects, analysis

methods, etc.) into the GeneMapper® ID-X Software v1.0 or v1.1
database host computer.

Select Tools » GeneMapper ID-X Manager. Then in the
GeneMapper /D-X Manager window, click each tab to import the
corresponding objects into GMID-X.

For information on creating user accounts and configuring the
Security Manager, Audit Manager, and E-Signature Administrator,
see the GeneMapper® ID-X Software Version 1.0 Administrators
Guide.

If you installed the GeneMapper® ID-X Software as either a remote
autoanalysis configuration, co-installation, or Data Collection client
installation, follow the procedures in Chapter 7, “Setting Up
Autoanalysis,” on page 68.
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Overview of Autoanalysis Process

62

Autoanalysis The autoanalysis process occurs in the following sequence:

Process

1. You close the GeneMapper® ID-X Software and start the

Autoanalysis Manager.

. On the Data Collection (DC) computer, you select the plate to

run and schedule the run.

. When the DC Software finishes a run as specified in the results

group, the data (.fsa sample files) are stored in the destination
specified by the DC Software results group.

. The DC Software sends the message “Run Completed” to the

Autoanalysis Manager. The Autoanalysis Manager searches for
jobs every two minutes.

. When the Autoanalysis Manager receives a “Run Completed”

message, it adds the job to its job queue.

. The Autoanalysis Manager:

a. Opens the GeneMapper® ID-X Software.

b. Creates a project using the name of the Data Collection
results group.

. The GeneMapper® ID-X Software:

a. Imports the .fsa sample files from the location specified in
the Data Collection results group.

b. Uses the settings specified in the Data Collection plate
record (panels and bins, analysis method, size standard) to
analyze the .fsa sample files.

c. Saves the project, then associates the data in the project
with the gmidx security group (for information on security
groups, see the GeneMapper® ID-X Sofiware Version 1.0
Administrator’s Guide).

GeneMapper® ID-X Software v1.0/1.1 Installation Guide



Chapter 7 Setting Up Autoanalysis ﬂ

Overview of Autoanalysis Process

d. Stores the results in the default host GeneMapper® ID-X
Software database.

Note: The default host is the GeneMapper ID-X Software
computer that is specified in the Login dialog box of the
computer that performs autoanalysis. For instructions on
changing the default host, see “Connecting to a New Host
on page 56.

E3]

8. The Autoanalysis Manager:
a. Closes the GeneMapper /D-X Software.

b. Updates the status of the run in the Autoanalysis Manager
job queue.

For information on the Autoanalysis Manager, see the
GeneMapper® ID-X Software Online Help.
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Determining if Your Computer Can Perform
Autoanalysis

Autoanalysis An autoanalysis configuration uses:

Software ¢ Data Collection Software — Runs the instrument and collects

Components data from samples. See “Instrument and software options for
autoanalysis” on page 65 to determine if your Data Collection
computer supports autoanalysis.

* Autoanalysis Manager — Communicates between the Data
Collection Software and the GeneMapper® ID-X Software. It
queues jobs and tracks the status of their processing. A job can
contain a single run or multiple runs as part of a result group.
+ GeneMapper® ID-X Software v1.0 (or v1.1) — Creates a
project, imports .fsa sample files, analyzes the data, then saves
the results in the multi-user database.
Figure 2 shows the relationship and interaction between the
autoanalysis components.
Stores in specified location Raw data p
fsa files — P GeneMapper ID-X
Software v1.0
Opens
Data Collection Autoanalysis Creates project
Software Manager +—
Run Closes and Multi-user database
complete reports status Analysis Methods
P

Figure 2 Relationship between autoanalysis components

Autoanalysis, which can be performed from a multi-user database
computer or a client, requires the Autoanalysis Manager.

To determine if your computer contains the Autoanalysis Manager,
select Start » Applied Biosystems » Autoanalysis Manager »
Autoanalysis Manager 3.0.
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Autoanalysis Instrument and Software
Configurations

With autoanalysis, the GeneMapper® ID-X Software v1.0 or v1.1 can
automatically analyze data generated on the following systems:

Table 7 Instrument and software options for autoanalysis

Compatible Data Collection
Software and Operating Systems
e 3130 Data Collection v3.0/

Applied Biosystems 3130/3130x/ 3130x/ Data Collection v3.0
Genetic Analyzer e Windows XP, SP 2 or later

Genetic Analyzer Instrument

¢ 3100 Data Collection v2.0/
ABI PrisM® 3100/3100-Avant™ 3100-Avant ™ Data Collection v2.0

Genetic Analyzer e Windows 2000, SP 3 or later

e 3730 Data Collection v3.0

Applied Biosystems 3730 e Windows XP, SP 2 or later
Genetic Analyzer¥

I The 3730 Genetic Analyzer does not include the 3730x/ 96-capillary configuration. The 48-capillary
configuration is validated for analysis of Identifiler® data generated from single-source data samples
only.
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Overview of Autoanalysis Setup

Local and Remote Autoanalysis

With the analyzers listed in Table 7, you can configure the Data
Collection Software and the GeneMapper® ID-X Software v1.0 or
v1.1 to perform data collection and then analyze the data
automatically, without user interaction.

The GeneMapper® ID-X Software v1.0 or v1.1 can be a co-
installation or a client installation on the DC computer (for local
autoanalysis). Alternatively, the software can be installed on a non-
DC computer and configured for remote autoanalysis with the DC
computer, as shown Figure 3.

Note: If you install the GeneMapper® ID-X Software on the same
computer as the Data Collection software (co-installation), you must
manually import the panel and bin files. See the GeneMapper® ID-X
Software Online Help for information on this procedure.

DC
computer
Local

Data
Collection
Software

Autoanalysis

Unshared

folder

T BO—

DC Non-DC
computer computer
Remote
Autoanalysis
or Data
GeneMapper /D- Collection m @ GeneMapper ID-X
Software Software Software
Shared
folder
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Figure 3 Examples of autoanalysis configurations
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Data Processing Options

The Autoanalysis feature of the GeneMapper® ID-X Software allows
you to set up a Data Collection run, then process the data
automatically in the GeneMapper® ID-X Software. Autoanalysis can
occur:

* Locally — from the DC computer when the Data Collection
software and GeneMapper® ID-X Software are installed on the
same computer.

* Remotely — from the non-DC computer when the Data
Collection software and GeneMapper® ID-X Software are
installed on different computers.

The Autoanalysis Manager is automatically installed when you
install the GeneMapper® ID-X Software on a:

* DC computer as a co-installation or client installation
* Non-DC computer for remote autoanalysis

Autoanalysis Manager is not installed when you install the
GeneMapper® ID-X Software on a non-DC computer in a stand-
alone configuration.

If the Autoanalysis Manager is not installed on your computer and
you want to use the computer for autoanalysis, uninstall the
GeneMapper® ID-X Software (see “Uninstalling the GMID-X
Software” on page 100), then reinstall for Remote Autoanalysis.

Before Setting Up  Before you set up autoanalysis:

Autoanalysis ¢ Ensure that the Data Collection Software and

GeneMapper® ID-X Software are installed in either of the
following configurations:

DC DC Non-DC

computer computer computer

Local Remote

Autoanalysis
Data 4 or Data

M. ID-X
Golecton " B p—pgareer > Collection 4 GeneMapper
Software Software d Software
Software Unshared o =

folder folder

Figure 4 Configurations necessary for autoanalysis

Autoanalysis
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If the software is installed on different computers, ensure that
the two computers are connected to the same network.

Ensure that the remote GeneMapper® ID-X Software computer
has the Autoanalysis Manager installed: Select Start »
Applied Biosystems » Autoanalysis Manager »
Autoanalysis Manager 3.0.

If the Autoanalysis Manager is not installed, you must uninstall
the GeneMapper® ID-X Software, then reinstall the
GeneMapper® ID-X Software and select the Remote
Autoanalysis option (see “Uninstalling the GMID-X Software”
on page 100).

Import or create analysis methods, panels, bins, and size
standards on the multi-user database host computer (see the
GeneMapper® ID-X Software Online Help).

If you install the GeneMapper® ID-X Software on the same
computer as the Data Collection software (co-installation), you
must manually import the panel and bin files. See the
GeneMapper® ID-X Software Online Help for information on
this procedure.

Setting Up Autoanalysis

The autoanalysis set-up process consists of four procedures as shown
in the following table.

Procedure Action ;:2\22
1. Create a User Account. 69
2. In the Data Collection Software, create an instrument protocol for 70
autoanalysis.
3. In the Data Collection Software, create a results group for autoanalysis. 72
4, In the Data Collection Software, create a plate record for autoanalysis. 80
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Procedure 1: Creating a User Account for Autoanalysis

IMPORTANT! The user account for autoanalysis must exist on the
computer that is specified as the host computer, which may be
different from the computer on which you run autoanalysis and store
data files (see Figure 5 on page 84).

Create a user account for autoanalysis with the following settings
(for information on creating user accounts, see the GeneMapper®
ID-X Software Version 1.0 Administrator s Guide). In the

GeneMapper ID-X Software Security Manager New User screen:

1.

Deselect Pre-expire.

IMPORTANT! If the account is set to pre-expire, you must log in
with the account one time to change the password before you
use the account for autoanalysis.

Select Scientist profile.

Note: If you create custom profiles for your system, create a
profile for autoanalysis with the following minimum privileges:
Read privileges for Panel Manager, Size Standard, Analysis
Method; Read and Update privileges for creating and analyzing
projects.

For Full Name, enter Remote Autoanalysis, Data Collection
Client, or Co-installation.

Deselect Show EULA.

Associate the user account with any user group. The project that
autoanalysis creates, analyzes, and saves is associated with the
GeneMapper® ID-X Software security group, which is
accessible by all user groups.

When you are finished, go to Procedure 2 and create an instrument

protocol.
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Procedure 2: Creating an Instrument Protocol for
Autoanalysis

An instrument protocol contains all the settings needed to run the
instrument, including the protocol name, type of run, run module,
and dye set.

IMPORTANT! Create new instrument protocols after installing or
reinstalling the GeneMapper® ID-X Software v1.0 or v1.1.

For more detailed information about instrument protocols, see your
instrument user guide.

Creating 1. In the Navigation pane of the Data Collection Software, select
Instrument GA Instruments » <Instrument Name> » Protocol Manager.

Protocols

2. In the Instruments Protocols section, click New to open the
Protocol Editor.

o GA Instrumerts = ga3130x] = Protocol Manager

Instrument Protocols

ame | Runiodue
31308 patialFill_1 3130SpatialFill_1
1 i 31 i_1
Spect36_POP4_1

3 1
F_POP4_36_spectral
Fragment-F
Fragment-G5

F t i
G5_POP4_36_spectral Spect36_POP4_1 65
< i

2 vew ) .

3. In the Protocol Editor, enter instrument protocol information:
a. Enter a name for the protocol.
b. (Optional) Enter a description for the protocol.
c. Select REGULAR in the Type drop-down list.
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d. Select the HIDFragmentAnalysis36_POP4_1 run module
in the Run Module drop-down list.

e. Select the appropriate dye in the Dye Set drop-down list
(see the table that follows to determine the dye).

Protocol Editor \E

hlame: ‘H|D —_ 3a
Description: 3b
Type:  REGULAR o 3c
Fun hiocule: \H\DFragmermwsis:ﬁjopu vl—— 3d
Dyeset o5 st 3e
Kit Dye Set
AmpF(STR® COfiler® Kit F

AmpF(STR® Profiler Plus® Kit

AmpF(STR® Profiler Plus ID Kit

AmpF{STR® SGM Plus® Kit

Other 4-Dye AmpF(STR® Kits

AmpF{STR® SEfiler™ Kit G5
AmpF(STR® Identifiler® Kit

AmpF{(STR® Yfiler® Kit

AmpF(STR® Minifiler™ Kit

Other 5-Dye AmpF(STR® Kits

f. Click OK.

When you are finished, go to Procedure 3 to create a Results Group
for autoanalysis.
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Procedure 3: Creating a Results Group for Autoanalysis

72

Overview of
Results Groups

Allelic Ladder
Requirements
and Results
Groups

Create a Results Group for each computer that performs
autoanalysis.

A Results Group specifies the file names and storage location
(shared folder) for .fsa sample files, and the user name and password
for the GeneMapper® ID-X Software computer that performs
autoanalysis. After you create the Results Group, the software can
perform autoanalysis.

Create new Results Groups after installing or reinstalling the
GeneMapper® ID-X Software v1.0 or v1.1.

IMPORTANT! The maximum number of .fsa sample files that the
Data Collection Software can assign to a Results Group, when using
the Analysis Type GeneMapperIDX-Generic or GeneMapperIDX-
<computer name>, is 7000. After you collect 7000 .fsa sample files
in a Results Group, you must create a new results group.

For more detailed information about results groups, see your specific
instrument user guide.

IMPORTANT! If a run folder does not contain an allelic ladder, the
samples are reported as off ladder (OL) in the GeneMapper® ID-X
Software. For more information, see the GeneMapper® ID-X
Software Online Help.

To set up the Data Collection Software so at least one allelic ladder is
present in each run folder, create a results group that groups by plate
as described below, instead of by run (which is the default).
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Creatinga  For each GeneMapper® ID-X Software client computer that runs
Results Group for autoanalysis:

Autoanalysis o ‘
1. In the Navigation pane of the Data Collection Software, select

GA Instruments » Results Group.

2. Click New to open the Results Group Editor, then click the tabs
of the results groups and enter the information as described
below.

Entering Results Group Information

1. In the General tab, enter the Results Group Name. This name is
assigned as the default autoanalysis project name (all results for
autoanalysis are stored in this GeneMapper® ID-X Software
project). The Results Group name must be unique to the Data
Collection Software.

2. (Optional) Enter the Results Group Owner.

3. (Optional) Enter a Results Group Comment.

mResuIts Group Editor

GeneréﬂlAnalysis Destination | Naming

Results Group Mame: — 1
Results Group Owner: | — 2
Results Group Comment:| — 3

OK | Cancel |
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Entering Analysis Parameters
. Click the Analysis tab.

2. For the Analysis Type, select GeneMapperIDX-

<computer name> (the name of the host or client computer on
which you intend to run autoanalysis).

Note: The computer names are added to the Analysis Type list
when you install the GeneMapper® ID-X Software as a co-
installation or client installation on the Data Collection
computer, or choose the remote autoanalysis option for the
non-DC computer.

Note: You cannot perform autoanalysis if you select
GeneMapperIDX-Generic.

. Select Do Autoanalysis.

. Select Results Group Entry Complete to start autoanalysis

after all samples that use the same results group (all samples on
the plate) have been run and to ensure that each run folder
contains an allelic ladder.

IMPORTANT! If a run folder does not contain an allelic ladder,
the samples are reported as off ladder (OL) in the GeneMapper®
ID-X Software. For more information, see the GeneMapper®
ID-X Software Online Help.
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5. In the Login ID and Password fields, enter a GeneMapper®
ID-X Software user account username and password for the
computer on which you intend to run autoanalysis. This account
must exist on the computer specified as the default host. The
default host computer may not be the computer on which you
perform autoanalysis (the computer running Autoanalysis
Manager) (see Figure 5 on page 84).

IMPORTANT! The GeneMapper /D-X Software requires a user
account with a Scientist or higher security profile to perform
autoanalysis (see “Procedure 1: Creating a User Account for
Autoanalysis” on page 69).

[l Results Group Editor

General Analysis | Destination | Maming

F\nalysis Typ

Genetdapper- 3130x/-08 2
Login ID |
—5
Password |
Analysis Action 3
H;DD Autoanalysis [~ Results Group Entry Cosss 4

Analyze Mow

OK | Cancel |
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Specifying the Sample File Storage Location
1. Click the Destination tab.
2. Specify the location in which to store the .fsa sample files

3. Select Use Custom Location.

r:";_‘:!Results Group Editor

4. Set the destination as described in the following table.

76 GeneMapper® ID-X Software v1.0/1.1 Installation Guide



Chapter 7 Setting Up Autoanalysis ﬂ
Setting Up Autoanalysis

For... Do the Following...
Local autoanalysis 1. Click Browse, then select a destination.
2. Click Test.
Remote autoanalysis 1. Before you specify the destination, verify that you can connect to the

computer on which you intend to store the .fsa sample files and that the
shared folder you previously created (see page 72) is accessible from
that computer.

Note: To optimize data sharing, store files on a non-GeneMapper® ID-X
Software computer (see page 83).

a. On the Data Collection computer, select the Start menu, then select
Run.

b. Enter the names of the computer on which you intend to store the
.fsa sample files and the shared folder, using the following format:

\\<server name>\<shared folder name>
For example: \\GMID_PC\Remote_AutoAnalysis

= Type the name of a program, Folder, dacument, or
5 Internet resource, and Windows will open it for you,

open: WEMID_PCWRemote_sutolnalysis v

[ K ][ Cancel ][ Browse...

c. Click OK.

If Windows Explorer opens to the shared folder on the designated
computer, the computer and shared folder are accessible. Close
Windows Explorer, then proceed to step 2.

If Windows Explorer does not open to the shared folder on the
designated computer, either the computer is not accessible, or the
shared folder is not set up correctly. Troubleshoot your network,
computer, or shared folder problem before proceeding to step 2.

2. In the Destination tab (see page 76), enter the names of the computer
on which you intend to store the .fsa sample files and the shared folder,
using the format shown in step 1b.

3. Click Test to test the location path name connection.
If the test:

¢ Passes — The message “Test succeeded” is displayed.

¢ Fails — The message “Could not make the connection. Please check
that the Path Name is correct” is displayed. Make sure you correctly
entered the computer and shared folder names, then troubleshoot your
network or computer before continuing.
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Creating Sample and Name Plates

In the naming tab, provide information about the samples:

1.
2.

3.

— File Extension 153

Click the Naming tab.

From the Format list in the Sample File Name Format section
(top), select a series of fields to create unique sample names, for
example, Well Position, Sample Name, and Capillary Position.

[@ Results Group Editor

| General | Analysis| Destination| Naming | automated Processing
rSample File Mame Format

Exarnple: Al2_Sample3_007 faa
Filename is greater than 13 characiers
Prefiz [ ‘
MNarme Delimitar
Farrnat I
’V|Well Position v | |sample Name v||Capillary Number v |<none> v

S | |

rRun Folder Mame Format

Exarnple: E4ppliedBiosystems\UDCDataCollectiontbinmaniSeqRlateds
INYALID NAME: Folder name does not have a unigue identifier in it

Frefi | ‘

MNarme Delimitar

Farmat |

M ||=none= hi H

ESp =N

Flate Mame

From the Format list in the Run Folder Name Format section
(bottom), select Plate Name.

IMPORTANT! To ensure that the run folder includes at least one
allelic ladder for genotyping, the run folder must be grouped by
plate, not by run.

When you select Plate Name, an INVALID NAME message is
displayed. Disregard the message. All samples from the plate
are saved into one run folder.

Note: Sample name, run folder name, and path name,
combined, can contain no more than 250 characters.
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Setting Automated Processing

1. Click the Automated Processing tab.

Note: This tab is available only if you selected
GeneMapperlDX-<computer name> in step 2 on page 74.

2. Select Only when the result group is complete to analyze after
all the samples that use the same results group have been
processed and click OK to save the results group.

Wi rovpranor x
General | Analysis| Destination| maming Automated Processing I
Autoanalysis is performed : SeleCt only
(('- Only when the rezults group is complete when the
" yhen every run completes result
group is
complete
=3 Canecel

When you are finished, go to Procedure 4 to create a plate record for
autoanalysis.
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Procedure 4: Creating a Plate Record for Autoanalysis

Defining New
Plate Information

80

A plate record specifies the instrument protocol, results group, and
analysis parameters for a run of samples. For more information about
plate records, see your instrument user guide.

IMPORTANT! Create new plate records after installing or
reinstalling the GeneMapper® ID-X Software v1.0 or v1.1, and
before each autoanalysis run. This procedure is provided in the
GeneMapper® ID-X Software Online Help.

In the Navigation pane of the Data Collection Software, click the
Plate Manager icon to display the Plate Editor.

IMPORTANT! Before you can create a new plate record, you must
specify or import the size standards, panels, and analysis methods in
the GeneMapper /D-X Software, then synchronize the Data
Collection Software with the GeneMapper® ID-X Software (see
page 90).

1. Click New to open the New Plate Dialog box.

2. Enter a name for the plate. The Plate Name is the name assigned
to the run folder that resides in the shared folder where the .fsa
sample files are stored.

3. (Optional) Enter a description for the plate.

4. Select GeneMapperIDX-<computer name> (the name of the
computer that you intend to have run autoanalysis) in the
Application drop-down list.

5. Select 96-well or 384-well in the Plate Type drop-down list.
6. Enter names for the owner and operator.

7. Click OK.
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New Plate Dialog
Mame: | ‘ 2
Description:
3
_ | 4
Application: |Nnne ¥ ‘
Plate Type:  |96-yell > 5

Owener Mame: | ‘:| 6
Operator Manme: | ‘

S

Describing the For each row in the Plate Editor (see page 82), describe the sample:

Sample
1. Enter the name of the sample.

After you make selections for the first row, you can select the

row, then press Ctrl+D to auto-populate (fill-down) the
remaining rows.

2. (Optional) Enter a comment about the sample. This information
is displayed in the Comment field of the Samples table in the
GeneMapper® ID-X Software.

3. Enter a priority number to specify the sequence in which the
samples are run.

4. Specify sample type:

a. Select Allelic Ladder as the sample type for the
appropriate wells (you need at least one allelic ladder per
plate to allow genotyping).

b. Select Positive Control or Negative Control for your
control samples to allow an automated concordance check
to ensure that the:

* Positive control produces the expected profile.

» Negative control does not contain peaks called above
your peak amplitude threshold.

GeneMapper® ID-X Software v1.0/1.1 Installation Guide 81



Chapter 7 Setting Up Autoanalysis

Setting Up Autoanalysis

10.

Plate Editor
1 2 3 4

c. Select Sample for all other samples.

Select a size standard from the drop-down list.

IMPORTANT! If the expected size standard, panel, and analysis
method are not listed, you may need to synchronize the Data
Collection Software and the GeneMapper® ID-X Software. See
page 90.

Select an applicable AmpF{STR® kit and panel from the
drop-down list.

Select an analysis method from the drop-down list.
(Optional) Enter text in the user-defined text columns.

Select the results group you created using the procedures on
page 72.

Select the instrument protocol you created using the procedures
on page 70. Click OK.

5 6 7 8 9 10

~

Pl | [ariee T
Pl iy Coami
¥iell Eamph| Mams | Cosnlnd | Friort| | Sample Tipe SEP‘MU.;MH_- Arkyeiz Misthoo SrpEe UperDefned1  User-Defred2 | User-Defined 3, fesulds Group 1 Instrnamsend Prolocol 1
=1 | [ \ \
M I
En
Fin
Len]
Hi
A
L 1 1 »
oererien
For more information on the Plate Editor, see your instrument user
guide. For information on performing autoanalysis and using the
Autoanalysis Manager, see the GeneMapper® ID-X Software Online
Help.
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Recommended Data Processing Tasks

Optimizing Data Sharing

Overview If you store .fsa sample files on a GeneMapper® ID-X Software
computer (ie, the computer that creates the project AND stores the
sample files), only the computer that created the project can
reanalyze the project. As a result, any other computer must
reassociate the files to reanalyze the project.

Additionally, if you export/import reference data and projects
following installation but do not reassociate .fsa sample files, you
can view results and make or edit allele calls, but you cannot
reanalyze the projects.

To reanalyze projects:

1. Move .fsa sample files to a non-GeneMapper® ID-X Software
computer to optimize file sharing.

2. Reassociate the .fsa sample files with the imported projects
(Edit » Define New Sample Path) to view raw and EPT data
and reanalyze the imported projects on your client computer.

Figure 5 shows the recommended configuration for optimizing data
sharing.
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Add
Samples
Sample to Project

files (.fsa) Networked Server (raw data) !
Shared
Folder

Client computer

Data Run <
Collection | completed | | Autoanalysis Opens | |GeneMapper ID-X
Software Manager Closes, then Software
updates status

Multi-user Database
Computer (Host)

Autoanalyze "

GeneMapper® ID-X

Can access Software

results and

| ithout Project
reanalyze W!t ou and
reassociating results
|' nt m ter —
Client compute - _} Multi-user J@
GeneMapper ID-X database

Software

Figure 5 Autoanalysis configuration to optimize data sharing

The following sections describe data optimization in detail. For
additional details on how to perform each procedure, see the
GeneMapper® ID-X Software Online Help.

Setting Up a Remote autoanalysis of data requires a shared folder in which to
Shared Folder store .fsa sample files. To make the sample data files accessible to all
(Remote client computers, set up the shared folder on a computer that is not
Autoanalysis  running the GeneMapper® ID-X Software.
Only)

On the computer on which you intend to store the .fsa sample files:

1. Select Start » My Computer, or double-click My Computer
on your desktop, then double-click the drive on which you want
the shared folder.

2. Select File » New » Folder.
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. Name the folder (for example, Remote_Autoanalysis).

. Right-click the new folder, then select Properties.

3

4

5. In the Sharing tab, select Share this folder.
6. (Optional) Enter a comment for the folder.
7

. Click OK.

Remote_Autoanalysis Properties |E|®

General| Sharing |Security Customize

= *Y'ou can share this folder with other uzers on your

network. To enable sharing for thiz folder, click Share this
falder.

(O Do not share this foldsr
(&) Share this folder 5

Share name: |F|em0te_AutoanaIysis

Comment: |Shared folder for remate autoanalysiz I 6
User limit: (®) Mavimum allowed
O Allow this number of users: l:l
To et permissions for users who access this
falder over the netwark, click Permissions. Sl
To c:o_nfigure zettings for offine access, click
Caching.

|
I

QK H Cancel ][ Apply ]
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Setting  If you use a Microsoft® Windows® XP® operating system, modify
Permissions and the permissions and security settings of the shared folder:
Security for the . .
Shared Folder 1- Right-click the shared folder, then select Properties.

ONIndOWOSn)I(;; 2. Select the Sharing tab, then click Permissions.

3. In the Permissions for <shared folder name> dialog box, select
the check box for Full Control in the Allow column.

4. Click OK.

Remote_Autoanalysis Properties ﬂ

| General| Sharing | Security. | Customize|

— REPEEUELEE) Permissions for Remote_Autoanalysis
network, Toe

folder. * Share Permissions |

(O Do not share this fif
(%) Share this folder

!ﬁ Everyone
Share name: | Remd|
Caomment: Share

User limit: *) M4
O alg

Group or user names:

To zet permissions for

it e (o ] Permizzions for Everyone

. . Full Control 3
To configure settings f h
Caching. ange
Read
‘ 4

D‘K H Cancel ][ Apply ]
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5. Select the Security tab, then click Add.

6. In the Select Users, Computers, or Groups dialog box, enter
Guest in the “Enter the object names to select” field.

7. Click OK.

Remote_Autoanalysis Properties

General | Sharing | Security |Eust0mize|

Group or user names:

@ d Select Users, Computers, or Groups
g H select this object type:
< - |Users,Groups, or Built-in security principals | [ Object Types... ]
From this location:
|na.ab.applera.net | [ Locations. .. ]
Permis:
Ful Enter the object names to select [examples):
WMod |Guest CITECE N aes 6
Fed
List
9 o) (o
it
.
7

For special permissions of for advanced settings,
d

click Advanced.

QK ][ Cancel ][ Apply ]
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8. In the Group or user names list box in the Security tab,
configure guest access:

a. Select Guest.

b. Select the check box for Full Control in the Allow

column.
c. Click OK.
Remote_futosnalysis Properties
General | Sharing | Security | Customize
Group or uzer names:
!ﬁ Adminiztrators [D4BPF 351 \Administrators] -
€7 CREATOR DWNER
ﬂ Guest [D4BPF3514Guest) Ba
o A
< ¥
[ Add... ] [ Bemove ]
Permizzions for Guest A"‘JW Deny 8b
Full Control 0 &
Madify O
Fead & Execute O
List Folder Contents O
Read |
write O »
For special permissions or for advanced settings.
click Advanced. =
| 8c
[ QK ] [ Cancel ] [ Apply ]

The shared folder is now configured for use.

Importing and  Depending on your current network configuration, you can import
Reassociating and reassociate the files in two ways:

Data Files + If the .fsa sample files are stored on a non-GeneMapper®
ID-X Software computer other than a user’s local computer —
The software saves the full networked path location of the .fsa
sample files (for example: //server/folder/folder*.fsa). Because
the path location is available to GMIDX, any computer in the
network can access the project and reanalyze it without
reassociating the files.
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 If the .fsa sample files are stored on a user’s local computer
(that is, the computer that creates the project AND stores
the sample files) - The software saves the path location of the
.fsa sample files, but not the name of the computer on which the
files reside (for example: C:/folder/folder*.fsa). The local
computer can reanalyze the files because GMIDX looks on the
local computer for the .fsa sample files. However, the name of
the computer is not available to other computers running
GMIDX so they cannot reanalyze projects without first
reassociating files (Edit » Define New Sample Path) (see
Figure 6 for file storage comparisons).

Sample files (.fsa) stored on a server computer not running GeneMapper® /D-X Software

Non-Genemapper

Multi-user Database Server computer Computer File Storage
Computer (not running
GeneMapper® ID-X Software)
GeneMapper® ID-X Client
Software computer

GeneMapper®
Multi-user ID-X Software

database

Creates a project, adds samples from server. Can open the project and reanalyze
Sample information, including full path location, because full path location
(\Lab01\Project1\) is stored in database. (W.ab0T\Project™Y) is stored in database.

Sample files (.fsa) stored on a computer running GeneMapper® /ID-X Software

Local Computer
File Storage

Multi-user Database

Computer
GeneMapper® ID-X Client
Software computer

GeneMapper®
Multi-user ID-X Software
database

[ c:\Lab01\Project1\ fsa files |

Can open the project but cannot reanalyze
without reassociating because computer name
is not stored in database.

Creates a project, adds samples from local computer.
Sample information with partial path location
(\Lab01\Project1)) is stored in database.

Local computer name is not stored in the database.

Figure 6 Storing .fsa sample files: non-GeneMapper® ID-X
Software computer vs. local computer
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After you install the GeneMapper® ID-X Software, and any time you
create or change analysis methods, panels, or size standards in the
GeneMapper® ID-X Software, you must synchronize the new data
with the Data Collection software before you can select the updated
items in the Data Collection Software plate record.

To synchronize the GeneMapper® ID-X Software with the Data
Collection Software:

1. Select File » Exit to close the GeneMapper® ID-X Software.

2. Verify that the Data Collection Software is running on the Data
Collection computer. If not, start the Data Collection Software.
For information on starting the Data Collection Software, see
“Starting the Data Collection Software on the 31xx Data
Collection Computer” on page 26.

3. On your desktc;g:
Double-click ..2... GeneMapper ID-X v1.0 (or v1.1),
or
Select Start » All Programs » Applied Biosystems »
GeneMapper » GeneMapper ID-X v1.0 (or v1.1) and log in.
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Installing the Generic Updater Software

Installing the Generic Updater Software

92

The Generic Updater software is an add-on to the 3730 and 3130
Data Collection 3.0 software. Use the Generic Updater to define
custom plates and write sample files to be used with the
GeneMapper® ID-X Software v1.0 or v1.1.

If you have either 3730 or 3130 Data Collection 3.0 software
installed on your computer, and you do not intend to install the
GeneMapper® ID-X Software v1.0 or v1.1 on the same computer for
either local or remote autoanalysis, you can install the Generic
Updater software on the Data Collection computer.

The generic Plate Editor, residing in the Plate Manager function, has
columns for GMID-X plate data that can be edited as text fields. The
software provides you with the option to add generic or non-
automated GMID-X plate definitions and sample files to your Data
Collection software installation.

To review the requirements for installing the Generic Updater
software, see “Installation Options” on page 3.

1. Insert one of the following CDs into the Data Collection
computer CD drive:

+ GeneMapper® ID-X Software Version 1.0
(or Version 1.1) Full Install CDs - Disk 1

»  GeneMapper® ID-X Software Version 1.0
(or Version 1.1) Client Install CD

2. Ensure that the Data Collection software is running (see
page 26).

3. On the splash screen, click Software Extras, then on the next
screen click Generic Updater.

4. On the following screen, click Install Generic Updater.

5. Click Browse, then select a location for the Generic Updater zip
files and click Unzip to extract the files.

6. Remove the GeneMapper® ID-X Software v1.0 (or vi.1) CD
from the CD drive.
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7. Navigate to the extracted folder on your hard drive. Open the
Deployment-Generic folder, then double-click RegisterGMID-
XGeneric.exe. A

8. Click OK when you see the message “Application
GeneMapper® successfully registered in JNDI.”

9. Stop the Data Collection software and restart your computer.

Start the Data Collection software and open the Viewer window, then
use the Plate Manager to create new GeneMapper /D-X Generic plate
definitions.

For instructions on creating and using GeneMapper® ID-X Generic
plates, see the User Guide for your specific instrument.

Resolving If RegisterGMID-XGeneric.exe reports an installation problem:

Installation _
Problems 1. Close the window and check the JNDIRegistrationGMID-
XGeneric log file in the extracted folder.

2. Check your Data Collection installation to verify that the Data
Collection software is running.

3. Try running RegisterGMID-XGeneric.exe again.
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Removing the Generic Updater Software
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IMPORTANT! If you decide to install the GeneMapper ID-X
Software directly onto the Data Collection computer or as a remote
autoanalysis configuration, you must first remove the Generic
Updater Software from the Data Collection computer.

To uninstall the Generic Updater Software:

1.

Ensure that the Data Collection Software is running (see
page 26).

Navigate to the extracted folder on your hard drive.

Open the Deployment-Generic folder, then double-click
UnRegisterGMID-XGeneric.exe to remove the
GeneMapperIDX-Generic option from the Data Collection
Software.

Click OK when you see the message “Application
GeneMapper® successfully unregistered in JNDI.”

Verify that the Generic Updater Software was removed:
a. Open the Data Collection Viewer window.
b. Open the Plate Manager.

c. Verify that the GeneMapperIDX-Generic option is not
available as an application choice.

Delete the Generic Updater Software files from your hard drive.
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Resolving If UnRegisterGMID-XGeneric.exe reports a problem and the
Uninstallation  Generic Updater software is still displayed in the Data Collection
Problems Viewer Plate Manager:

1. Check the JNDIRegistrationGMID-XGeneric log file in the
extracted folder.

2. Check your Data Collection installation to verify that the Data
Collection software is running.

3. Run UnRegisterGMID-XGeneric.exe again.
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96 GeneMapper® [D-X Software v1.0/1.1 Installation Guide



Appendix B

Troubleshooting
the Installation

This appendix covers: H
98

B Troubleshooting Tasks. . .......... ... ... ... .. .....

B Troubleshooting Tools. . .......... ... ... . ia... 105

GeneMapper® ID-X Software v1.0/1.1 Installation Guide 97



Appendix B Troubleshooting the Installation
— Troubleshooting Tasks

Troubleshooting Tasks

Disabling Firewall Protections

During a full GeneMapper® ID-X Software installation, the security
firewall settings may prevent the database from installing. You may
see Windows security alerts that prompt you to “keep blocking” or
“unblock” the security firewalls. Alternatively, it may appear that the
installation was complete but when you start the software, the
database may not launch.

1. Before installing GMID-X v1.0 or v1.1, disable the firewall
settings: go to Start » Control Panel » Windows Firewall to
disable the settings.

2. At or during installation, if you are prompted with Window
firewall alerts, click Unblock and proceed with installation.

If the software application doesn’t launch:
* Uninstall the software (see “Uninstalling the GMID-X
Software” on page 100).

» Disable the firewall settings by going to Start » Control
Panel » Windows Firewall,
or
Disable the firewall settings for your particular Windows
operating system. Go to Start » Control Panel » Security
Center for Windows online support.

3. Reinstall the software for your specific ID-X configuration.

4. Reset firewall.
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Canceling an Installation

General Installation Solutions

Obtaining the
Installation
Log File

DO NOT cancel an installation before the installation process is
finished. If you do so, or if the installation otherwise stalls, you may
need technical support to perform an uninstall. To uninstall your
installation, see “Uninstalling the GMID-X Software” on page 100.
If uninstallation fails, contact your local Applied Biosystems
technical support organization.

Note: You may need to send the GMIDX install and MSI log files to
Applied Biosystems Technical Support if the troubleshooting
procedures in this appendix do not solve the installation problem.

If you have trouble installing the GeneMapper® ID-X Software v1.0
or v1.1 on your computer:

Task See page
1. Obtain the installation log file. 99
2. Check the database installation. 100
3. If necessary, uninstall the software. 100
4. If necessary, have a knowledgeable technician run the 102
clean-up utility.

To obtain the installation log file, go to:
x:{installdir \Applied Biosystems\GeneMapper ID-X where x is
the drive on which the GeneMapper /D-X Software is installed and
{installdir} is the user-selected installation path.

* You will find 2 logs for the full installation:
— GMIDXInstall.log
— GMIDX_MSIl.log

* You will find 2 logs for the client installation:
— GMIDXClientInstall.log
— GMIDXClient_MSI.log
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Checking the 1. Select Start » All Programs » Accessories »
Database Command Prompt.

Installation
2. Enter sqlplus, then press Enter.

3. Enter the user name, system, then press Enter.

4. Enter the password, manager, then press Enter.

» Ifa“Connected to:” message is displayed, the database is
installed correctly.

* Ifno “Connected to:” message is displayed, the database is
not installed correctly. Complete Table 6, “Troubleshooting
Checklist,” on page 105, then contact Applied Biosystems
Technical Support.

Uninstalling the  To uninstall the GeneMapper® ID-X Software and the multi-user
GMID-X Software database:

1. If you are uninstalling a co-installation, Data Collection client
installation, or a remote autoanalysis configuration, start the
Data Collection software (see page 26).

2. Close the GeneMapper® ID-X Software and all other
applications, then restart the computer before proceeding with
the uninstall.

IMPORTANT! If you do not restart the computer before
proceeding with the uninstall and/or if the uninstall does not
complete successfully the first time, perform this procedure a
second time. If the uninstall still does not work, have a
knowledgeable technician review and proceed with “Running
the Clean-up Utility” on page 102 or contact Applied
Biosystems Technical Support to proceed.

3. Select Start » Control Panel.
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4. Double-click Add or Remove Programs.

Note: If a message indicates that you need administrator rights
or privileges, log off the computer, then log on again as a user
with administrator privileges.

Note: If you receive an error message, dismiss the message and
proceed to “Running the Clean-up Utility” on page 102.

Select the GeneMapper® ID-X Software.
Click Change/Remove. The InstallShield Wizard opens.

In the Welcome page, select Remove, then click Next.

©@ N o O

At the prompt, click OK to verify the uninstall.

* Ifyou are uninstalling a Co-installation or Data Collection
client installation, the message below appears. Be sure the
Data Collection Service Console is open, then click OK to
start the uninstall.

Warning

!

E Please make sure Data Collection services are on during the Uninstall,

Click OK to continue the Uninstall,

» Ifyou are uninstalling a remote autoanalysis configuration,
no message is displayed; however, the Data Collection
Software must be running and the Service Console open on
the remote Data Collection computer to uninstall a remote
autoanalysis configuration.
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9. When the Maintenance Complete window opens, finish the
uninstallation process:

IMPORTANT! If you uninstall a co-installation or Data
Collection client installation, stop the Data Collection Software
before restarting your computer by clicking Stop All in the
Service Console.

Service Console

Messaging Service

Data Service

Instrumert Service

Wiever

[sem +——— Stop Al

a. Select Yes, I want to restart my computer now.

b. Click Finish.

Running the Run the clean-up utility under only the following conditions:
Clean-up Utility

* You have attempted the uninstall procedure using the
Add/Remove Program uninstall option,

and
¢ The GMID-X v1.0 or v1.1 software files were not removed or
were only partially removed.

Have only a knowledgeable technician run the msicuu2.exe utility to
clean up the remaining files.
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To perform the clean-up procedure:

1.

Insert the GeneMapper® ID-X Software CD, then go to
DVD/CD-RW Drive » Utilities.

Run msicuu?.exe to install the utility.

Launch the utility from the desktop icon or from
Start » Programs » Windows to install.

Select the GeneMapper /D-X application from the list provided,
then click Remove.

a. Check to ensure that the gmidx install folder and
oraclegmidx folder under your {installdir} are deleted.

b. Check to ensure that the Oracle folder in the Program Files
folder is deleted.

Delete variable strings:

IMPORTANT! Steps 5 and 6 must be performed carefully and
correctly. If they are not performed correctly, other applications
could stop working, and the stability of your system could be at
risk. If you do not feel comfortable performing these steps,
please contact your system administrator to perform them for
you.

a. Right-click on My Computer, then select Properties.
b. Click the Advanced tab.

o

Click the Environment Variables button.

d. In the System variables Variable pane, delete the words
ORACLE_HOME and ORACLE_HOSTNAME.

e. In the System variables Variable pane, select the Path
variable and click the Edit button.

f. Remove the path to oraclegmidx from the path
environment variable.

g. Click OK to exit the Environment Variables dialog box and
OK to exit the System Properties dialog box.
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6. Go to Start » Run and enter regedit. In the left-pane of the
Registry Editor, open the following folders sequentially:
HKEY_LOCAL_MACHINE » SYSTEM

» CurrentControlSet » Services.

a. In the Services folder remove all Oracle folders containing
IFA letters only.
¢ OracleIFAGMIDXCMan
* OraclelFADataGatherer
* OracleIFAGMIDXTNSListener
* OraclelFAAgent
* OracleIFAClientCache
* OracleIFAGMIDXCMAdmin
* OracleServicelFA
* OracleJobSchedulerIFA

b. Log off and reboot the system.
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Troubleshooting Tools

Complete the Troubleshooting Checklist and Interdepartment Forms
before contacting Applied Biosystems Technical Support for
assistance.

Checklist
Table 6 Troubleshooting Checklist

Check Information for Technical Support

Summarize the problem:

Can you repeat the problem?
If yes, list the steps that you perform:

N o oo~

Applied Biosystems personnel that you have contacted:

A Field Applications Specialist
[ Field Service Engineer

[ Technical Support

[ Sales Representative

[ Order Administration

a Other
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Check

Information for Technical Support

Computer specifications:

e Operating system:

e \ersion:

e Processor:

e Memory:

e Hard disk space:

¢ Hard disk configuration:

Software installed:

[ Data Collection Software version:

1 Status of Data Collection services:
1 GeneMapper ID-X Software version:
[ Other Applied Biosystems software:

Computer login information:
e User privileges:
¢ Local or networked domain:

Software configuration installed:
[ Co-installation

[ Remote autoanalysis

1 Stand-alone

1 Multi-user database

Instrument and instrument computer information:

e Model:

e Data Collection Software version:

e Status of Data Collection services:
e Other Applied Biosystems software:
e Capillary length:

¢ Capillary lot number:

e Run module:

¢ Dye set:

Chemistry kit or reagent, with version number:
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Check Information for Technical Support

Be prepared to send to Technical Support:

¢ Installation log file (page 99)

e Exported panels

e Exported bins

e Exported size standard definition

¢ Exported analysis method

e Sample (.fsa) files

¢ GMIDXInstall.log or GMIDXClientInstall.log
¢ PanellmportLog.txt

¢ Printed results

Interdepartmental Forms

Answering questions in the following forms helps manage complex
troubleshooting procedures. Your answers will be shared among
support groups, product groups and software development teams at
Applied Biosystems.

To address any issues that may arise when installing or running the
software, please answer the applicable list of questions, and collect
the necessary files before contacting Technical Support.
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For Installation Collect the following files and complete the questions below:

ISSUES  or full installation:

* GMIDXInstall.log
* GMIDX_MSl.log

For client installation:
* GMIDXClientInstall.log
* GMIDXClient_MSI.log

Do the computer and operating system meet the required computer specifications? (See Chapter 2,
“Installation Requirements,” on page 7.)
List any potential discrepancies.

Did you receive any error messages or alerts? If so, what did they say? (if possible, take screen
captures.) At what point during the installation process did these errors/alerts occur?

How many installation attempts have you tried?

Are you logged in to the local computer?

Is the TCP/IP configured?

Do you have administrative privileges?

Is this setup stand-alone, networked, or connected to a Genetic Analyzer?
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For Post-
Installation
Related Issues

Do the computer and operating system meet the required computer specifications? (See Chapter 2,
“Installation Requirements,” on page 7.)
List any potential discrepancies.

Problem description:

Did you receive any error messages or alerts? If so, what did they say? (If possible, take screen
captures.) At what point did these errors/alerts occur?

Is the problem reproducible?

Steps taken prior to encountering or to reproduce the problem:
1.
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Definition of Terms

Client Installation

Co-Installation
(31xx)

Data Collection
Client Installation

310 Data
Collection (DC)
Computer

31xx or 3730 Data
Collection (DC)
Computer

Data Collection
Software

112

A computer installed with the GeneMapper® ID-X Software only
(software with no database). A client installation computer connects
to a full installation computer to access the multi-user database. A
client can be installed on a Data Collection (DC) computer, or it can
be installed on a non-Data Collection (non-DC) computer in either a
remote autoanalysis or stand-alone configuration.

A full installation (database and GeneMapper® ID-X Software) on a
Data Collection computer that can be set to communicate locally
with the Data Collection software for the collection and processing
of .fsa sample files, and the analysis of data. Not recommended in a
multiuser database configuration because the multi-user host is
limited to a one-client-connection.

An installation (GeneMapper® ID-X Software only) on a Data
Collection computer that can be set to communicate locally with the
Data Collection software for the collection and processing of .fsa
sample files, and the analysis of data. Connects to a multi-user
database host computer to access, analyze, and share data and
analysis settings.

A stand-alone computer with Data Collection software that controls
the Genetic Analyzer instrument and generates .fsa sample files used
for analysis by the host or client computer GeneMapper® ID-X
Software.

A computer with Data Collection software that controls the Genetic
Analyzer instrument and generates .fsa sample files used for analysis
by the host or client computer GeneMapper® ID-X Software. Can
support a co-installation or client installation.

The software on the Data Collection computer that controls the

Genetic Analyzer instrument and generates the .fsa sample files used
for analysis.
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Full Installation

Genetic Analyzer

GMID
GMID-X

Local Area
Network

Local
Autoanalysis

Multi-User
Database Host
Computer

Non-Data
Collection

(Non-DC)
Computer
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A computer installed with both the multi-user database and
GeneMapper ID-X Software.

A full installation computer can be part of a multi-user database
configuration, or it can be a data collection (DC) or non-data-
collection (non-DC) computer having no interaction with other
computers. A full installation can occur in any of the following
configurations, depending on the function of the computer:

* Co-installation
* Remote Autoanalysis

» Stand-alone

The capillary electrophoresis instrument, controlled by the Data
Collection software, which generates .fsa sample files.

Abbreviation for GeneMapper® ID Software.
Abbreviation for GeneMapper® ID-X Software.

A communications network that serves users within a confined
geographical area.

A co-installation (database and GeneMapper® ID-X Software) or
client installation (GeneMapper® ID-X Software only) that is set up
on a Data Collection computer to locally communicate with the Data
Collection software for the collection and processing of .fsa sample
files, and the analysis of data.

A computer on which data is stored on a central, multi-user database.
Commonly referred to as the host computer, from which other client
computers (computers without a database) can access, analyze, and
share data. Can be installed for a remote autoanalysis or stand-alone
configuration.

A non-data collection computer that may or may not be connected to

a local area network (LAN). Can be a client installation or full
installation, with a stand-alone or remote autoanalysis configuration.
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Stand-alone
Configuration

Upgrade
Installation

Remote
Autoanalysis

A full installation (database and GeneMapper® ID-X Software) or
client installation (GeneMapper® ID-X Software with no database)
on a non-Data Collection computer that does not remotely
communicate with the Data Collection computer. Can be the
database host or client computer in a multi-user database
configuration.

A software upgrade from GeneMapper® ID-X Software v1.0 or
v1.0.1 to GeneMapper® ID-X Software v1.1. The upgrade can be
performed on a client or full installation computer that already has
the v1.0 or v1.0.1 software installed. However, to upgrade on a client
computer, you must also upgrade the computer that hosts the full
multi-user database installation.

A full or client installation on a non-Data Collection computer that is
set up remotely to communicate with the Data Collection computer
(data collection software) for the automatic acquisition and analysis
of data. Can be the database host or client computer in a multi-user
database configuration.
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